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LICENSE NOTICE, LIMITED
WARRANTY AND DISCLAIMER
AND LIMITATION OF LIABILITY

Abracadata, Ltd. grants to Licensee the non-exclusive license to use the Software on one computer and to make a backup copy of
the Software for Licensee’s own use. The “Licensee” is the single individual or business entity for whom the Software was original-
ly purchased. All rights and protections under federal, state and international law, including but not limited to the law of copyright,
patent, trademark, trade secret and contract, shall remain in full force and effect. Licensee may not download, reproduce, distrib-
ute, republish, sell, rent, lease, sublicense, or translate the Software or documentation in violation of those laws and this License.
The Software remains confidential, proprietary information, in which Abracadata, Ltd., the authors, suppliers and developers of the
Software claim trade secret rights. Licensee may not modify, reverse engineer, decompile or disassemble the Software.
Abracadata, Ltd. warrants to Licensee and to no other person or entity that the physical disks provided to Licensee (but not the
Software recorded on them or the documentation), are free from defects in materials or workmanship for a period of 30 days
from the original purchase date. Abracadata cannot guaranty that the program will operate on all systems that meet the minimum
specifications indicated on the box. If during this 30-day period a defect should occur, the original disk(s) may be returned with a
copy of your dated sales receipt and a brief description of the problem to Abracadata, Ltd., PO Box 2440, Eugene, OR 97402, for
replacement free of charge. Licensee’s sole remedy in the event of a defect in the disk is limited to replacement of the disk. As
stated below, Abracadata disclaims any and all implied warranty is found to exist, it shall terminate no later than 30 days after
purchase. If the disk has been physically damaged, is beyond the 30-day limit or is not accompanied by proof of purchase, include
$10.00 for each disk plus $3.00 postage and handling per request. Please return the disk only, not the entire package. Do not
staple or paper clip the disk. Package the disk carefully to prevent bending, and mark the package Do Not X-Ray or Use Magnets.
Ship via UPS or U.S. Postal Service with return receipt requested. Abracadata, Ltd. is not responsible for disks not received when
Licensee cannot provide proof of shipment and Abracadata, Ltd.’s receipt.
This Limited Warranty does not grant and specifically excludes any right to recover any other damages whatsoever, including but
not limited to, loss of profit, loss of information, business interruption, or special, incidental, or consequential damages or other
similar claims, arising out of the use or inability to use the Software or documentation, even if Abracadata, Ltd. has been
specifically advised of such damages. In no event shall Abracadata, Ltd.’s liability for any damages to Licensee or any other person
ever exceed the actual price paid for the Software, regardless of the form of the claim.
In all other respects, the Software and documentation is licensed AS IS, WITH ALL FAULTS. ABRACADATA, LTD. SPECIFICALLY
DISCLAIMS ALL OTHER WARRANTIES REGARDING THE SOFTWARE AND DOCUMENTATION, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Abracadata, Ltd.
specifically makes no representation or warranty that the Software is fit for any particular purpose.
This Limited Warranty gives Licensee specific legal rights. Licensee may have others, which vary from state to state. Because some
states or provinces do not allow the exclusion or limitation of liability for consequential or incidental damages, or the limitation on
duration of an implied warranty, some of the limitations may not apply to Licensee.
Abracadata, Ltd. gives no assurance that the information used in the development of the Software is reliable and accurate. Any
recommendations or suggested results in the Software represent only the generic opinions and judgments of the author and are
intended to be applicable in a variety of circumstances. However, individual circumstances vary and may render certain
recommendations and results inapplicable. Abracadata, Ltd. gives no assurance that the opinions or judgments of the author are
reliable or accurate.
If any provision of this License is held to be unenforceable, it will be construed to have the broadest interpretation that would
make it valid and enforceable. Invalidity or unenforceability of one provision will not affect any other provision of this License. This
License shall be governed by the laws of the State of Oregon.



4



5
3D Railroad

Table of Contents

3D RAILROAD: WHO, WHAT, WHEN AND HOW? 11
What’s 3D Railroad Concept and Design? 11
System Requirements 12
How To Install 3D Railroad  on your hard disk 12
How to use this manual 13

General Information 13
When To Call Technical Support Services 14
Who’s On The Abracadata Team? 15

3D Railroad Production 15
The Artists 15
Box Artwork 15
Content Coordinators 15
The Computer Systems and TeNeT Teams 15
Programmers 16
The Abracadata Team 16
The Manual 16
Additional Contributors 16

WHAT ARE THE BASICS? 19
The Mouse 19
Keyboard Shortcuts 20

MENU KEYBOARD SHORTCUTS 20
DRAWING KEYBOARD SHORTCUTS 21

Main Menu Bar 21
Status Bar 21
Selecting, Resizing and Altering Objects 22

CONTROL SYMBOLS 22
Selector Tool Symbol 22
Square Symbols 23

Black Square = Resize Handle 23
Hollow Square = Radius or Proportional Handle 23

Circle Symbols 24
Circles = Resize Handles 24

Straight track or line sections: 24
Polygons 24
Circles = Radius Handles 24

Arcs; Curved Lines and Tracks; and Spline Lines and Tracks 24
Round Boxes 25

The “+” Symbol = Rotate Handle 25
ERASING OBJECTS 25



6

Erasing A Whole Object 25
Erasing A Part of An Object 26

PROPERTIES DIALOG BOXES 26
Using Colors and Patterns 27

Color 27
Patterns 27

Standard Patterns 27
Custom Patterns 28

Textures 29
Line Width 29
Arrow Style, Length and Width 30
Reports Information Section 30
Apply settings commands 31
Open File Dialog 31
Group Properties 32
Track Properties 32

Setting Track Elevations And Grades 33
Creating a Spiral Helix 36

3D Bitmap Properties 37
3D Object Properties 38
2D Object Properties 40

Using 3D Railroad 43
USING THE TRACK TOOLS 43
CREATING A SAMPLE TURNOUT / SWITCH 47
USING TRACK AND OBJECT LIBRARIES 50
ABOUT THE SYMBOL LIBRARIES 52

Resizing Grouped Symbols 52
“Place Holder” Symbols 54
Put Selection in Library 55

TAKING A VIRTUAL 3D WALK-AROUND 56
RUNNING A TEST TRAIN 57
CREATING CUSTOM BENCHWORK 59

Insert Benchwork 60
CREATING ACCURATE TURNOUTS/SWITCHES 60

Setting The 3D Backdrop 61
CREATING SYMBOL LIBRARIES 61

To Open an Existing Library, or Create a New Library 61
To Create a 2D Library Symbol and Add It To a Library 62
To Create a 3D-linked Bitmap or 3D-linked Object and Add It To a Library 62

WHAT ARE ALL THOSE MENUS AND BUTTONS? 67
Main Menu 67



7
3D Railroad

“FILE” MENU ITEMS 68
New 68
Open 68
Close 69
Save 69
Save As 69
Document Setup 70
Page Setup 70
Print Preview 71
Print 72
Print 3D View 72
Quit 73

“EDIT” MENU ITEMS 73
Undo 73
Cut 74
Copy 74
Paste 74
Duplicate 74
Select All 75
Properties 75

“TOOLS” MENU ITEMS 75
Run Test Train 76
Set Camera Position 77

To change angle of camera view 78
Rotate Around Origin 79
Selector 79
Draw Sub-Menu 80

Sketch 80
Line 82
Box and Oval 83
Round Box 85
Arc 86
Polygon 87
Spline 89
Text 91

“Track” Menu 93
Straight Track 94
Curved Track 96
Oval Track 97
Spline Track 99

Dimension Submenu 101
Draw Dimension Line 101
Draw Dimension Angle 103



8

Draw Measure Line 105
Draw Measure Box 106

Insert Submenu 108
Insert 2D Bitmap Picture 108
Insert 3D Bitmap 109
Insert 3D Object 110
Insert Benchwork 111

Put Selection into Library 112
Get Object From Library 113

About The Symbol Libraries 113
Resizing Grouped Symbols 113
“Place Holder” Symbols 115

To Get a Selection From the Library 116
“VIEW” MENU ITEMS 117

3D View 117
Show 3D View 118
Show 3D as Wireframe 119
Reset Camera 120
Birds-Eye View 120
Left-Side View 120
Right Side View 121
Front View 122
Back View 122
Lighten 123
Darken 123

Zoom In 123
Zoom Out 124
Normal Zoom 125
Fit To Screen 125
Grid 126
Status Bar 126
Object Sizes 127
Tool Bars… 127

“ARRANGE” MENU ITEMS 128
Send to Back 128
Send to Front 129
Rotate left (90) 129
Rotate right(90) 130
Rotate (180) 130
Rotate By Degrees 131
Lock 132
Unlock 132
Group (Ctrl+G) 133
UnGroup… (Ctrl+U) 133



9
3D Railroad

Edit Group 134
Exit Edit Group 134

“REPORTS” MENU ITEMS 135
Create Materials Report 135
Manufacturer Parts List 137

“OPTIONS” MENU ITEMS 138
Normal Track Snap 139
Snap to Grid 139
Snap to Object Corners 139
Reverse Track Snap 140
Preferences 140

Metrics & Grid Tab 140
3D View Tab 141
Train Tab 141
Other Tab 142
Folders Tab 143

“WINDOW” MENU ITEMS 143
“HELP” MENU ITEMS 143

Working With “Layers” 145

GENERAL INFORMATION 147
List of Manufacturers 147
Command Card 154
Metric Conversion Tables 158

INDEX 159



10



11
3D Railroad

3D RAILROAD: WHO, WHAT, WHEN AND HOW?

WHAT’S 3D RAILROAD CONCEPT AND DESIGN?
3D Railroad Concept And Design (3D Railroad) lets you quickly and easily
design 2D railroad layouts and simultaneously view them in rich, texture-
mapped 3D graphics.

Now you can actually view and walk around your design in a virtual 3D world!

POWERFUL TOOLS
3D Railroad’s powerful drawing and editing tools let you easily create to-scale
track and other layout elements. There are special track tools for drawing
straight, curved, and spline-based track (bendable flex track). There is also a
complete set of drawing tools for creating 2D scenery or other model structures.

IT’S EASY
You don’t need special drawing skills! There’s a complete set of ready-to-use,
2D and 3D symbol libraries. The database information, part numbers, prices,
etc. included with these libraries also lets you calculate costs, print materials
lists, and generate reports. And, the databases and libraries are also editable.

FEATURES
A few of the many powerful features provided in 3D Railroad include:
• A benchwork tool for creating virtually any shape of benchwork
• Hundreds of 3D textures for the 3D benchwork, roadbed, and other symbols
• Print to-scale templates of your design
• Zoom in/out capabilities
• Single-degree object rotation
• Elevated tracks
• Customizable user interface (tools can be repositioned or torn off into

floating tool palettes)
• Support for scanned backdrop scenes/pictures
• The ability to run a test train and watch it in 2D and 3D
• Track snap for easier and more precise positioning of track pieces
• Measuring tools
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SYSTEM REQUIREMENTS
You must have the following minimum computer equipment to operate
3D Railroad:

• A Power Macintosh or compatible computer running Mac OS 7.5 or higher

• A minimum of 32 MB of memory (more is better)

• A display monitor running 256 colors or more

• A hard disk drive with a minimum of 80 MB of free space available

• A double (or higher) speed CD-ROM disk drive

HOW TO INSTALL 3D Railroad  ON YOUR HARD DISK
To install 3D Railroad on your hard drive:

• Insert the 3D Railroad CD-ROM into your CD-ROM drive.

• Double-click on the the 3D Railroad CD to open the CD.

• Drag the 3D Railroad folder onto your hard drive icon.

Note: This will copy all needed application files to your hard drive and create
the appropriate icons or menu items for 3D Railroad. You will still need to
insert the 3D Railroad CD-ROM into your drive when you run the program to
be able to access the extensive 3D Railroad data.

3D Railroad: Who, What, When and How?
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HOW TO USE THIS MANUAL
There are four sections in this manual: 3D Railroad: Who, What, When and How;
What Are the Basics?; What Are All Those Menus and Buttons?; and General
Information. Note: There are a number of new features and processes, so it would
be wise for experienced users to read the manual prior to setting up a layout …
each time you use the manual you’ll find information you missed before.

3D RAILROAD: WHO, WHAT, WHEN AND HOW
This section tells you what 3D Railroad is all about, what kind of computer
system you need to use 3D Railroad, how to install the software, what to do if
you have questions, who put 3D Railroad together, and a step-by-step tutorial.

WHAT ARE THE BASICS?
An overview of the areas that control the majority of 3D Railroad operations:
the Mouse, Control Symbols, Keyboard, Status Bar, Main Menu Bar, Properties
Dialog Boxes. You’ll find more detailed instructions on these processes in the
What Are All Those Menus and Buttons? section.

WHAT ARE ALL THOSE MENUS AND BUTTONS?
Detailed explanations for each Menu item and Toolbar button, including how to:

•  Set up, maintain, and print your plan •  View your plan from different angles
•  Work with and edit your plan •  Control and move objects
•  Use the drawing tools •  Create reports
•  Place track •  Work with windows
•  Measure objects •  Get help
•  Insert 2D and 3D pictures

GENERAL INFORMATION
List of Manufacturers: The names, addresses, phone numbers, and e-mail
addresses for manufacturers who have provided parts lists for 3D Railroad.
Note: Price lists were provided by the manufacturers and were included with
the application as a service to 3D Railroad customers. Please contact the
manufacturers directly regarding current prices, updates or materials questions
you might have. Manufacturer addresses and phone numbers are found under
“Credits” on the APPLE menu and in the General Information section of this
manual. The manufacturers’ parts lists are editable and you can create your own
lists. This lets you easily enter updated prices and product information.
Command Card: A quick reference for toolbar buttons, and keyboard shortcuts.
Metric Conversion Table: For yards … inches, and meters … centimeters.



14

WHEN TO CALL TECHNICAL SUPPORT SERVICES
Abracadata appreciates your support and interest in using our products!

We provide free technical support so, if you have questions about 3D Railroad
operations — and you’ve checked your manual but are still unable to find an
answer to your question — help is only a phone call away. We only ask that you
pay for the call so that we may continue to provide economical products for you
and all our customers.

However, to save both yourself and our technical-support staff time, please look
through this manual for the solution before you call. You’ll find many of the
answers here … and they are already written down!

If you cannot find the answer and need to call technical support, we’ll be there
to make the experience as hassle free as possible. After all, we know how
frustrating it can be to call technical support at many software companies —
we’ve been in that situation ourselves.

We’ve come up with the following ways to speed up the process and cut down
the nail biting. Prior to calling technical support:

1. Determine what version of 3D Railroad you have. Note: You’ll find it on the
title page of this manual and by selecting ABOUT 3D RAILROAD under the
“Apple” Menu.

2. Have your computer and system configuration information available. We
may need to know what computer hardware you have, video type, resolution,
colors, and what version of system software you are using.

3. Know how much memory you have in your computer; its configuration; the
screen savers you use; other programs you are running atthe same time as
3D Railroad; and the file-compression program you are using, if any.

4. Call Abracadata’s technical support number, 541 342-3030, between
8:30 AM and 4:30 PM Pacific time. Note: Please don’t call our order lines
for technical support. These employees are not trained for technical support.

3D Railroad: Who, What, When and How?
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WHAT ARE THE BASICS?

THE MOUSE
If you’re not already familiar with using a Mouse, get ready to grow an
appendage because, in working on your railroad plan, the Mouse is as vital as
your hands! You will use it to select, move, resize, draw and quickly access
dialog boxes.

The following is a summary of the ways 3D Railroad uses the Mouse to work,
but there are some terms you need to know before you can put the Mouse to
work for you.

• Clicking  simply means to press down and immediately release the button
located at the top of the Mouse.

• Double clicking is doing the same thing as clicking, only doing it twice.

• Dragging means to press and hold the mouse button down while you move
the Mouse. Note: To do this, you will be moving the Mouse around your
mouse pad. Don’t worry if you reach the edge of the pad … just lift the
Mouse up off the pad (continuing to keep the mouse-button down) and set it
back down in a new place that has room for you to continue moving it.

Now, for ways to use the Mouse:

Selecting objects and text: The Mouse is your control over the Pointer, a small
icon (often an arrow) on your screen. To select something, move the Selector
Arrow over the item you want to select, then click the mouse-button. Note: In
this manual, the Pointer is most frequently referred to as the Selector Arrow and
when you are typing text, it might also be called a Cursor.

Pointing: Move the Mouse to point the Selector Arrow or pointer at an object.

Moving: Once an object is selected, you can move it by dragging it to the
desired location.

Resizing: Once an object is selected, you can resize it by dragging on its
resizing control symbol. Depending upon the object you select, the symbol will
be a black square, a hollow square, or a hollow circle. Note: See Selecting,
Resizing and Altering Objects in this section.
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Rotating: Once an object is selected, you can use the Mouse to rotate it. Note:
See Selecting, Resizing and Altering Objects in this section for specific
instructions.

Quickly accessing the Properties dialog box: To quickly access an object’s
Properties dialog box, click on the object you want the information for while
holding the control key.

Drawing:  The Mouse “pointer” is used for drawing objects on the drawing
area. Note: Depending on the object to be drawn, the Mouse pointer may take
on the appearance of an arrow, cross-hair, hand, pencil or other symbol. Please
see the What Are All Those Menus and Buttons? section.

KEYBOARD SHORTCUTS
The keyboard is essential for some actions (e.g. typing text) but, for some
operations, it can also be easier and faster to use than the Mouse. The following
is a list of keyboard “shortcuts” for some of those operations.

MENU KEYBOARD SHORTCUTS
Keyboard shortcuts are alternatives to using the Mouse. Note: Do not press the
+ sign, just press the two keys indicated.

Operation Key Strokes
New document Cmd+N
Open file Cmd+O
Save Cmd+S
Print Cmd+P
Undo Cmd+Z
Cut Cmd+X
Copy Cmd+C
Paste Cmd+V
Delete Delete
Group Cmd+G
Ungroup Cmd+U

What are the Basics?
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DRAWING KEYBOARD SHORTCUTS

Operation Key Strokes

Constrain Straight Track SHIFT while drawing Straight Track

Keep Tool Caps Lock

MAIN MENU BAR
The strip at the top of the screen is called the “Main Menu.” The words on it —
“File,” “Edit,” “Tools,” “View,” “Arrange,” “Reports,” “Options,” Window,” and
“Help” — represent menus of commands. To open a menu, place the Selector
on the word for the menu item and press and hold the mouse button.

Main Menu items open pull-down windows that contain commands.

• Commands followed by an ellipsis ( … ) means there is an additional
subwindow with special options or instructions.

• Dimmed (gray text instead of black) means command cannot be selected.

• Some commands are followed by a combination of keys (e.g. Cmd+N).
These are called keyboard shortcuts and are alternatives to using the Mouse.
Note: Do not press the + sign, just press the two keys indicated.

STATUS BAR
The Status Bar, located at the bottom of the 3D Railroad window, provides a
wealth of information that is easily viewed at all times. It consistently displays
the type of tool you are using and its location on your plan. Then, depending
upon the type of tool you’re using, it will display a range of other information
such as: object name, the height, width, area, radius, angle, length, rotation
angle, object start-end location, object center, cursor location, grade, etc.
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SELECTING, RESIZING AND ALTERING OBJECTS

CONTROL SYMBOLS

You will be seeing a lot of control symbols as you build your plan, so it is
essential you understand exactly what 3D Railroad control symbols are and
how to use them. Fortunately, the 3D Railroad symbols are few and are easily
understood and used.

In addition to the Selector Arrow, which is a part of almost all selection
activities, there are three other main groups of control symbols: squares, circles
and the “+” sign.

SELECTOR TOOL SYMBOL

3D Railroad’s Selector Tool Arrow looks and operates much the same as the
Macintosh Selector Arrow. It, and an untitled plan window, appears as soon as
you open the 3D Railroad application.

If, after you are working on your plan, the Selector is not visible, you can
access it by either clicking on SELECTOR in the Tools menu or on the Selector
tool icon on the toolbar

       

To use the Selector: Move the Selector over the object you want to select and
click. Small black squares, called handles will appear when the object is
selected. Note: In the case of grouped objects, you may see one or more square
handles. (How to use handles is covered in the “Square Symbols” section later
in this section.)

You can now manipulate — move, resize, copy, cut, etc. — the object.

What are the Basics?
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To select multiple objects: Hold down the Shift key as you point and click on
each additional object. Note: Another option is to:

1. Place your Mouse beyond the edge of all the objects you want to select.

2. Hold down the mouse button while dragging the Mouse across the objects. All
objects touched by the resulting dashed-line box will be selected.

3. Release mouse button.

To deselect an object(s) or text: Click on any unselected place on the plan.

SQUARE SYMBOLS

BLACK  SQUARE = RESIZE HANDLE

As was mentioned in the Selector section, when you select an object or text,
black squares called resize handles appear at each corner of the selected item.
Use these handles to resize objects.

Note: Straight lines and tracks, curves, and grouped objects are exceptions to
this rule. Please refer to the “Circles” section later in this section or to the
individual object’s extended description in the What Are All Those Menus and
Buttons? section.

To resize an object: Click on any one of the resize handles with the mouse
button and drag the handle until you reach the desired size.

HOLLOW  SQUARE = RADIUS OR PROPORTIONAL  HANDLE
The hollow squares are used to change the radius of a curve or proportionally
resize a grouped object. They only appear when you select a section of curve or
spline track, a spline line or a grouped object.

To change the radius of a curve: After selecting the objects, drag the hollow
square inward or outward to make the radius smaller or larger. Note: You can
also alter the radius by dragging one of the two accompanying circles.
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To change the size of a grouped object: After selecting the group, drag the
hollow-square handle at the upper right corner of the group. Note: The handle
may appear at a different location if you have rotated the group.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

CIRCLE SYMBOLS

The circle symbols operate differently for each object.

CIRCLES = RESIZE HANDLES

Straight track or line sections:
The circles appear at each end of the track or line sections and are used to
lengthen/shorten the track or line.

To lengthen/shorten a track or line section: After selecting the track or line,
use the mouse button to drag the circle until you reach the desired length.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

POLYGONS

The circles appear at the ends of each side of the polygon and are used to
lengthen/shorten the side.

To lengthen/shorten a side: After selecting the polygon, use the mouse button
to drag one of the circles on the side you wish to lengthen/shorten until you
reach the desired length.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

CIRCLES = RADIUS HANDLES

Arcs; Curved Lines and Tracks; and Spline Lines and Tracks
The circles can be used to change the length or radius of a curve. They only
appear when you select a section of curve or spline track, or a spline line and
they are always accompanied by a dotted line.

What are the Basics?
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To change the length or radius of a curve: After selecting the object, use the
mouse button to drag one of the circles for the curve you wish to change until
you reach the size you want. Note: You can also alter the radius by dragging the
accompanying hollow square.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

Round Boxes
The circles on a round box are used to alter the shape of its corners.

To alter the shape of a corner: When you select a round box, two circles
appear at each of its corners. Use the mouse button to drag one of the circles.
Note: All the corners will change at the same time.

THE “+” SYMBOL = ROTATE HANDLE

When you draw, place or select an object or text, a “+” symbol appears at some
point near the selected item. (Usually near a corner or the beginning or ending
point of a line.) Dragging this “+” allows you to rotate the object or text. Note:
You can also use the ROTATE items under the “Arrange” menu. Or, to rotate the
object around a selected origin point, use the ROTATE tool from the Toolbar.

ERASING OBJECTS

3D Railroad is an object-oriented drawing program. Unlike a painting program,
each thing you draw, whether a line, circle or rectangle, is a separate object.
This is an ideal environment for designing programs like 3D Railroad , which
must scale drawings and maintain a scaled relationship with real-world sizes.
But, since everything drawn is an object, it isn’t possible to erase — by rubbing
away or cutting out a piece as you can in a paint program — an object such as a
rectangle or any portion of it

However, there are several ways you can simulate an erase.

ERASING A WHOLE OBJECT
The Selector tool lets you erase (actually delete) unwanted objects.
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1. Activate the Selector tool — remember you can access it either through the
“Tools” menu bar or by clicking on its icon on the toolbar.

2. Select the object(s) you want to remove.

3. Press the “Delete” key or choose CLEAR from the “Edit” menu.

For help with selecting, see Selecting, Resizing and Altering Objects in this section.

ERASING A PART OF AN OBJECT
You can achieve what looks like a partial erase in two ways; 1) resizing the
object or 2) drawing on top of the unwanted part of an object with another
white object.

Resizing an object. For example, if a line is too long, rather than erase the part
that’s too long, you can grab its handle and size it down. (Please refer to the
Black Square = Resize Handle section earlier in this section.)

Drawing on top of an object. To erase part of an object with a white object:
Click the correct tool for drawing the desired white object over the unwanted
part of your object. Note: Please see the “Color” section of the properties dialog
box for the object you’re going to use as a cover.
Illustration: Portions of this circle and line have been erased by drawing over
them with a white oval, rectangle and line.

PROPERTIES DIALOG BOXES

Every object on your plan has a Properties Dialog Box that typically contains at
least three areas: 1) physical attributes of your object; 2) object information for
inclusion in the materials reports; 3) a selection bar that allows you to search
the files for different items, e.g. textures, patterns, 2D and 3D objects, etc.

All properties boxes can be accessed by holding the control key and clicking
the mouse button on an object. However, each object’s box is unique to its type.

What are the Basics?
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USING COLORS AND PATTERNS
COLOR
Many of the Properties dialog boxes give you the option of selecting or defining
a color.

To select or define a color:

1. Click on the color bar and the Color dialog box opens automatically.

2. Select your color choice.

3. If you don’t see the exact color you want, you can set a custom color:

• Manipulate Hue, Saturation and Brightness value by moving the cross-
hairs on the color wheel or by adjusting the numbers in the percentage
boxes on the right. Note: Different operating systems may have
different ways of selecting color changes.

• Click “Ok” to apply color to object.

PATTERNS

After bringing up the object’s properties box, check the “Use fill” box followed
by the “Use pattern” box. To apply color to your pattern click on the color bar,
then follow the same steps you took to set the “Fill Color” in the previous
section.

Standard Patterns
Clicking on the empty circle next to “Patterns” activates the pattern selection
bar.  Scroll through the pull-down menu selection of patterns.
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Custom Patterns
Clicking on the empty circle next to “Custom” allows you to create your own
pattern. Clicking on the “Browse” button opens the “Edit Pattern” dialog
box.

       

• Click LOAD to open/load a pattern from disk. Click “Pattern names” to
create or edit a pattern.

• Click “OK.” Note; If you created a new pattern, you are given the
opportunity to save it to disk for future use.

What are the Basics?
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TEXTURES

It is possible to select/change the texture of many of the 3D Railroad objects.
When the dialog box opens for texture selection, review the list, then click on
the file you wish to use. There’s a wide range of textures to choose from, such
as grass, sand, dirt, and woodgrains, and they can displayed for you in the
preview box, immediately to the right of the file listings.

Note: What we refer to as roadbed texture is called ballast in hobby stores. With
3D Railroad, you not only have a variety of ballast textures to choose from, you
can also select track that has matching ballast between the rails and ties.

LINE WIDTH
You have a choice of nine line widths.
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ARROW STYLE, LENGTH AND WIDTH
You have a choice of three arrow styles lengths and widths. Click on the pull-
down menus for each attribute in the dimension line properties box. To apply
color follow the same steps as for applying color to any other object.

REPORTS INFORMATION SECTION
Report-information fields are a part of the majority of properties dialog boxes.
They include category, manufacturer, scale, type, name, part number, price, and
notes. There is also a “Show in report” check box. Note: If you want an object
included in the materials reports, you must click this box.

What are the Basics?
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APPLY SETTINGS COMMANDS
These three (four choices with tracks) choices control which objects are
impacted by your settings choices, the clicked piece only, all selected items, or
to all items . Click on your preference

OPEN FILE DIALOG

You have three choices to use or not use:

1. Click on the upside down triangle next to the folder-name box to select other
areas of your disk.

2. Choose the “Folder” icon from the “Main” menu tool bar.

3. Choose “Open” from the “File” menu.
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GROUP PROPERTIES

There are three specific group areas:

Price: Allows you to set your prices as either automatic or fixed. Automatic
calculates the group’s component objects’ total price. Fixed uses the price
specified for the whole group.

Allow group expansion in reports: If this option is enabled, you can double
click grouped objects in the MATERIAL REPORTS DIALOG to list a group’s
component objects.

Use border: If you wish to use a border around your grouped objects, click
here. You also have the option of setting a color for your border. Please refer to
the“Using Colors and Patterns” in this section.

TRACK PROPERTIES

The Track Properties dialog box lets you specify a variety of parameters and
reports information related to track — Length, Radius(1), Radius(2), Start
angle, ArcDegrees, Grade %, Elevation1, Elevation2, Railspacing, Tie length,
Tie spacing, Track sep, Show axis, Show ties, Resizable option, Normal/Bridge/
Tunnel, Roadbed Width and Height, and Track and Roadbed Appearance.

To access Properties: Click on the track, using the Right Mouse-Button and a
TRACK PROPERTIES DIALOG box appears.

What are the Basics?
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Following is a description of each item in the Track Properties dialog:

Preview Box: Shows the selected/clicked piece of track. Changes you make to
the properties are also previewed here. Click “OK” to keep the changes, or
CANCEL to discard them, and exit the dialog.

Length: Shows the length of the selected track. In the case of straight track,
length can be entered here and the change will be applied to the track when you
click “OK.” Note: Though lengths are shown for other types of track, you
cannot change the length entry for them.

Radius(1): Shows the radius of curved track, and the first radius (the width
parameter) of oval track. If desired, you can specify a new radius and the
change takes effect when you click “OK.”

Radius(2): Shows the second radius (the height parameter) that’s used to draw
oval track (it’s set to zero in the case of curved track). Again, you can change
the radius and the change takes effect when you click “OK.”

Start angle: Shows the start angle of curved and oval track arcs.

ArcDegrees: Shows the length of curved and oval track arcs in degrees. Note:
The arcs extend counterclockwise from the start angle.
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Grade: Shows the percentage of grade change between the track’s start and
end. If the start and end elevations are the same, then the track is level and the
grade is zero.

Elevation1: Specifies the 3D elevation of the track’s start point. You can specify
track elevations in the “Track Properties” dialog box. Note: The preset amount
is enough to elevate the track to the top of the default roadbed height.

Elevation2: Specifies the 3D elevation of the track’s end point. Again, you can
specify track elevations in the “Track Properties” dialog box. Note: The preset
amount is enough to elevate the track to the top of the default roadbed height.

Rail spacing: Shows the distance between the track’s rails. (This distance
changes depending on the train scale information in the reports fields. Note:
There is a train scale that can be changed [in the Metrics & Grid tab under
PREFERENCES on the “Options” menu] that affects the default spacing for this.)
You can also specifically enter a different spacing, as well as the rail color.

Tie length: Indicates the length of the track’s ties. (This distance changes
depending on the train scale information in the reports fields. Note: There is a
train scale that can be changed [in the Metrics & Grid tab under PREFERENCES

on the “Options” menu] that affects the default spacing for this.) You can also
specifically enter a different spacing, as well as the tie color.

Tie spacing: This shows the distance between the track’s ties. (This distance
changes depending on the train scale information in the reports fields. Note:
There is a train scale that can be changed [in the Metrics & Grid tab under
PREFERENCES on the “Options” menu] that affects the default spacing for this.)
You can also specifically enter a different spacing.

Number of rails: Sets your preferred number of rails. (single, double or triple)

Show Axis: Shows a blue axis line in the center of track, between the rails.

Show Ties: Shows/hides the track’s ties.

Resizeable: Indicates whether to allow the track to be resized.

Normal:  Set for normal track. Note: In the case of elevated track, the roadbed
is extended downward to the benchwork.

What are the Basics?
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Bridge: Overrides extending roadbed downward to the benchwork for elevated
track. This lets you create elevated track that floats so you can place hills, piers,
or other structures beneath it as supports.

Tunnel: Lets you specify track to be used for the inside of a tunnel.

Roadbed W/H: Sets the 3D width and height of roadbed.

Track:  When you click on the box below the track selection box, the
“Textures” folder opens for you to select the type of track you prefer. When
you’ve made your selection, click on OPEN and you return to the Track
Properties window. Note: All the track textures begin with the word “Track”
with the tie color and ballast type appended (e.g., TrackBrwTie Buff). You will
need to scroll to the right to see the track textures. Click a texture name to see it
in the preview box.

Roadbed: The current roadbed ballast texture filename is shown here. When
you click on the box immediately to the right of the roadbed selection box, the
“Textures” folder automatically opens for you to select the type of roadbed you
prefer. You can choose from a variety of ballast textures for the roadbed. Note:
All the ballast textures begin with the word “Ballast” with the ballast type
appended (e.g., Ballast Buff). This lets you easily match the ballast for the track
with the ballast for the roadbed (e.g., Ballast Buff matches TrackBrwTie Buff).
Click a texture name to see it in the preview box.

When you’ve made your selection, click on Open and your selections will be
entered and you will return to the Track Properties window.

Reports Information:  Sets the database information that appears in materials
reports. Enter the data as you would like it to appear in reports, and click on the
“Show in report” box. Note: If you want an object included in the materials
reports, you must click this box.

Show in report: Enable this option if you want the object and reports inform-
ation to appear in the materials reports dialog, and in material reports printouts.

Apply settings to clicked piece only: Applies properties changes only to the
clicked piece of track, even if more than one piece of track is selected.

Apply setting to all selected: Applies properties changes to all selected track.

Apply settings to all: Applies properties settings to all track, selected or not.



36

Apply settings as defaults: Uses the properties settings as track-tools defaults.

Note: Use the“Bridge track” properties option to keep roadbed from
automatically extending downward to the benchwork. This lets you create
elevated track that floats so you can place hills, piers, or other structures
beneath it as supports, as well as creating overpasses.

CREATING  A SPIRAL  HELIX

Use curved track pieces to create a circular helix track that spirals in elevation.

1. Use the curved track tool to draw a curve of the desired radius. Note:
Depending upon the size of the track, you might find it convenient to zoom
out once on your drawing.

2. Bring up “Properties” dialog box for selected piece of track.

3. Set the track type to “Bridge track.” This disables building the 3D roadbed
downward until it meets the benchwork (zero altitude) Instead, it keeps the
roadbed at the specified height.

4. Set the ArcDegrees to 180° to create a half-circle.

5. Set “Elevation 1” to the desired elevation.

6. Click “O.K.” to exit the properties dialog. If you want to align the curve
vertically, choose ROTATE BY DEGREES under the “Arrange” menu, type in
60, and click “O.K.” Note: The elevated end is now at the bottom endpoint
of the curve.

7. Duplicate the curved track.

8. Snap the top end of the new piece to the bottom end of the existing piece.
(Just move the two ends close to one another and release the mouse button to
snap them together.) The elevation at the snapped connection adjusts
automatically to the existing piece’s elevation.

9. Select the new piece while holding the control key to set its elevation in the
properties dialog.

10. Repeat Step #7 until you’ve completed a helix of the desired height.

It might be helpful to follow the results in the 3D view as you create the helix.
Also, depending upon the size of the track, it might be helpful to zoom out once

What are the Basics?
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on your drawing. Note: A predrawn spiral helix has been provided in the
“Samples” folder as an example.

3D BITMAP PROPERTIES

Used to import a masked bitmap picture that will appear in the 3D view and to
set report fields and other properties for the picture.

File name: Clicking on BROWSE automatically opens the folder “3DBitmaps”
for you to select a bitmap. There are several areas to this dialog box. Refer to
OPEN FILE DIALOG earlier in this section for more specific information.

Elevation: Determines the distance above the benchwork that the 3D Bitmap
will be placed.

Resizeable: Controls whether or not a bitmap can be resized once it’s placed on
your plan. Note: You can change this setting at any time by simply returning to
the Properties dialog box.

Show in 2D plan: Shows the bitmap in your 2D plan rather than an “X” box.

Hide cross-reference box when object is grouped: Draws a top view
representation of the bitmap using the draw tools. When enabled, you can group
the top view object with the “X” box and the “X” box will disappear, leaving
only your drawn object. Note: All of the provided bitmaps are trees, for which
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2D top views have been created. To access these, use the library feature and
open libraries that begin with the word “trees.” This tool is only necessary to
customize a top view or create custom masked-bitmaps.

Apply settings commands: These three choices control which objects are
impacted by your settings choices, the clicked piece only, all selected items, or
all items. Click on your preference.

3D OBJECT PROPERTIES

Used to import a 3D studio or DXF object and texture; set height; elevation; report
fields, cross-reference control and resizable option; and apply settings. (For more
information, refer to CREATING LIBRARY SYMBOLS in the Tutorial section.)

File name: Clicking on BROWSE automatically opens the “Scripts” folder for
you to select an object from the 3D Studio files. There are several areas to this
dialog box. Refer to the OPEN FILE DIALOG information in this section.

Texture name: Clicking on BROWSE automatically opens the “Textures” folder
for you to select an object from the Bitmap texture files.

What are the Basics?
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Once you’ve made your selections, you will notice that your 3D object and
texture selections are displayed in the preview window. The five large buttons at
the right side of the preview window have a direct effect on your 3D object.

Upward-Pointing Arrow Button: Proportionally enlarges your 3D object.

Downward-Pointing Arrow Button: Proportionally reduces your 3D object.

Preview: This button — toggling with the “Adjust orientation” button
immediately below it — controls the display of your object. In the “Preview”
mode, your object revolves, displaying all sides.

Adjust orientation: Stops your object’s rotation and freezes it to a front view.
Now you can move into the preview area, grab the object using the mouse
button, and manually rotate it. Use SHIFT to constrain rotation to the X or Y
axis only. To continue the object’s rotation, click on “Preview.”

Restore object: Restores your object to its original size.

Height: Sets the desired height of the 3D Object. Note: This is not a
proportional adjustment. Click on the “Restore object” button to return to the
object’s proportional height.

Elevation: Determines the distance above the benchwork that the 3D Object
will be placed.

Resizeable: Controls whether or not an object can be resized once it’s placed
on your plan. Note: You can change this setting at any time by simply returning
to the Properties dialog box.

Show in 2D plan: This generates a wireframe view of your object and shows it
on the 2D plan. Note: The wireframes can be complex and draw very slowly, so
use this discretionally.

Hide cross-reference box when object is grouped: Select this option to draw
a top view representation of the 3D object using the draw tools. When enabled,
you can group the top view object with the “X” box and the “X” box will
disappear, leaving only your drawn object. (For more information, refer to
CREATING LIBRARY SYMBOLS in the Tutorial section of this manual.)

Apply settings commands: These three choices control which objects are
impacted by your settings choices, the clicked piece only, all selected items, or
to all items. Click on your preference.
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2D OBJECT PROPERTIES

These set the line style, width and color of 2D objects; To access Properties:

1. Bring up “Object” properties. A dialog window with two tab screen choices,
Line and Fill appears.

Line Tab sets the line width and color; and lets you choose which objects to
apply the settings to. Refer to LINE WIDTH; USING COLORS AND PATTERNS;
REPORTS INFORMATION; AND APPLYING SETTINGS earlier in this section for
more specific information.

Fill Tab sets fill and color, and pattern design. Refer to USING COLORS AND

PATTERNS under “Properties Dialog Box” in the What Are the Basics? section
of this manual for more specific information.

Fill Check Box: When you click on this box, you will be able to select the
color of the fill you want to apply to your object.

Pattern Check Box: When you click on this box, you will be able to select the
pattern color you want to apply to your object.

What are the Basics?
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USING 3D RAILROAD
There’s no way this manual could explain everything about model railroading.
So we’ll focus on how to use 3D Railroad’s powerful features to plan and
experiment with railroad layouts, without the expense and time of building and
rebuilding the real thing.

Not only that, you can actually try everything out (via virtual 3D), print a full-
size template to build from, generate a shopping list of needed materials, and
then construct your railroad with confidence!

This tutorial, as well as the other information contained in this manual, will
give you step-by-step instructions on how to create a sample HO scale layout.

Now, let’s get started.

First, select NEW under the “File” on the main menu bar. This will open an
empty, untitled drawing window to work within.

It would be a good idea to give your test plan a name before proceeding. To do
this, click on SAVE AS. (You’ll find it under “File” too.) Note: For specifics
about all menu items, refer to the What Are All Those Menus and Buttons?
section of this manual.

USING THE TRACK TOOLS

1. SET THE PREFERRED DRAWING  UNITS. To set the units:

• Select PREFERENCES under the “Options” menu.

• Under the Metrics & Grid tab, make sure to set units to inches, decimal
it is usually the default selection.

• Click “OK.”
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Note: The default train scale for track tools is HO scale. To work in a
different train scale, set Default train scale (immediately below Units), to
the scale you wish to use. This sets the scale for reports information; and
adjusts the rail and tie spacing to the preferred scale.

These changes can also be made for individual track pieces in the TRACK

PROPERTIES DIALOG box. For more information, refer to “Setting Track
Properties” later in this tutorial; or in TRACK PROPERTIES under the “Properties
Dialog Boxes” in the What Are the Basics? section of this manual.

2. DETERMINE  AND SETUP YOUR OVERALL  LAYOUT  SIZE. This step is
handled with Document Setup under the “File” menu. Note: For specifics
about all menu items, refer to the What Are All Those Menus and Buttons?
section of this manual.

• Set the width to 96" and the height to 48" (the size of a 4' x 8' piece of
plywood). Note: This also defines the size of the benchwork that
appears in the 3D view (e.g., the green grassy area beneath track).

In your own designs, you would set this according to the amount of
space required by your layout. However, you can use the benchwork
tool to create custom benchwork, which then takes precedence over
this size. You’ll learn about these features in their respective sections
elsewhere in the manual.

• Leave all the other DOCUMENT SETUP options at their current settings.

• Click “OK”

3. DRAW A STRAIGHT  SECTION OF TRACK .

• Click the straight track tool.

          

• Move into the drawing window about an inch from the top of the
window and a little to the left of center, hold down the SHIFT key and
drag a 24" section of track to size. The length and angle of the track is
shown on-screen as you draw, and is also shown in the status bar at the
bottom of the window. Note: Holding the Shift key makes it easier to
draw perfectly straight track.

         

Using 3D Railroad
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Tip: If you are having trouble getting the precision that you desire, use the
zoom tool or select ZOOM IN under the “View” menu. The more you zoom in
on your drawing, the greater the precision.

4. DRAW A 90° CURVE.

• Click the curved track tool.

• Move into an empty area of the drawing window and drag the mouse
button down and to the right to create a curved track section that has a
radius of approximately 15" (Again, don’t worry about being perfectly
exact.). Note: The length of the track, followed by the radius, appears
on-screen as you draw.

• Bring up the curved-track properties dialog box. To change the curve’s
arc length, type 15 for the radius and 90 for the ArcDegrees (length of
arc).

• Click “OK.” The track resizes precisely to the specified dimensions.

5. SNAP THE CURVE TO THE END OF THE STRAIGHT  TRACK .

• Move onto the curved track and hold down the mouse button close to
the right end of the straight track.

• Release the button. The curve automatically snaps and aligns with the
end of the straight track. Note: You’ll quickly appreciate 3D Railroad’s
smart track snapping functionality. It’s a real time saver and lets you
easily create precise track connections.
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6. DUPLICATE  THE CURVE AND SNAP IT  TO THE OPPOSITE END OF THE
STRAIGHT  TRACK .

• Select the original curve and press Cmd+D or select DUPLICATE under
the “Edit” menu to make a second copy of the curved track.

• Move onto the copy of the curve and position the bottom of the curve
near the other end of the straight section of track. The curve flips and
rotates to the correct orientation and snaps into place.

Note: If you inadvertently snap a piece of track into the wrong orientation,
simply drag the opposite end of the track near the desired connecting point
to re-snap it into the correct orientation.

You’ve now created the top half of the sample oval track layout.

7. GROUP THE THREE TRACK  PIECES TOGETHER .

• Hold the SHIFT key and click each piece of track to select them all.

• Select GROUP under the “Arrange” menu or click the group tool
button.

All of the track will now be treated as a single object.

8. DUPLICATE  THE TOP HALF  OF THE TRACK  LAYOUT .

• The grouped track should still be selected, but if not, click it to select
it, then press Cmd+D.

Using 3D Railroad
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9. ROTATE  BY 180°.
• Select ROTATE (180) under the “Arrange” menu to rotate the lower half

of the track layout to the needed orientation.

• Move onto the track layout

• Drag the left endpoint of the bottom half of the layout to the left
endpoint of the top half.

• Release the button. The bottom half of the layout snaps into position.

You have now completed a sample oval track layout. (If you would like to
create a spiral helix, refer to CREATING A SPIRAL HELIX in the What Are The
Basics? section of this manual.)

If you would like to take a break now and continue with the sample layout at a
later time, select SAVE under the “File” menu to save a copy of your work to
disk. When you’re ready to continue, select OPEN under the “File” menu to
open your file, then continue on with the next section. Note: For specifics about
all menu items, refer to the What Are All Those Menus and Buttons? section of
this manual.

CREATING A SAMPLE TURNOUT / SWITCH

This section demonstrates how to use the track tools to create a switch by
adding a spur to the sample oval layout you created in the previous section.

1. DRAW A 10" RADIUS CURVE.

• Move into the center area of your oval track, or any empty area of the
drawing.

• Click on the curved track tool
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• Draw a curved section of track with a 10" radius, approximately. It’s
not important that the radius is exactly 10" since this is only for
demonstrations purposes.

        

2. CHANGE THE TRACK  SNAP OPTIONS.

Click the Reverse Track Snap button, which causes track snapping to be
reverse of normal.

3. SNAP THE CURVE INTO  POSITION TO CREATE A SWITCH .

• Move onto the curved piece of track and drag the top end of the curve
to the left end of the existing top section of straight track (where the
straight track joins with the upper left curve of the oval layout).

• Release the button. The curve snaps into place, creating a turnout.
Note: If the curve snaps to the wrong orientation, it means that it
snapped to the existing 90° curve rather than the straight track (since
both are at the same location). In this case, change to NORMAL TRACK

SNAP (see Step #4) and click the turnout curve again.

Note: A red switch indicator now appears where the three pieces of track
connect. Clicking on such switch indicators controls the direction the switch
is thrown when running test trains.

4. CHANGE TO NORMAL  TRACK  SNAP.

Using 3D Railroad



49
3D Railroad

• Click on NORMAL TRACK SNAP under the “Options” menu or use the
NORMAL TRACK SNAP button to change back to normal track
snapping.

5. DRAW A 10" SECTION OF STRAIGHT  TRACK .

• Draw a 10" section of straight track and snap it to the end of the curved
turnout.

6. DRAW ANOTHER  10" RADIUS CURVE.

• Draw another curve and snap it’s “bottom” to the end of the newly
added straight section.

7. DRAW ANOTHER  10" STRAIGHT  SECTION.

• Draw another straight section and snap it to the end of the newly added
curve.

8. ADD A BUMPER.

• Click GET OBJECT FROM LIBRARY under the “Tools” menu, or its
toolbar button. The LIBRARY PROPERTIES DIALOG box will open. For
more specific information, refer to “Properties Dialog Boxes” in the
What Are the Basics? section of this manual.

• Click the Open button and locate the library file “Tutorial.rrl”

• Click OPEN.
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• Click the SHOW CATEGORY AND SELECT ALL tab to show all objects
in the library.

• Click Life-Like’s part #21308 bumper.

• Click the ADD TO PLAN button. The bumper appears near the center of
the drawing window.

• Move onto the bumper and drag its track end to the open end of the
straight track.

• Release the button and the bumper snaps into place.

Congratulations! You have now completed a sample oval track layout that
contains a turnout and spur as shown in the preceding illustration.

This was a very basic demonstration of how to use some of the 3D Railroad
track tools but you can use the same techniques to create more complicated
layouts. The other track tools are explained in What Are All Those Menus and
Buttons? section of this manual.

If you would like to take a break now and continue with the sample layout at a
later time, select SAVE under the “File” menu to save a copy of your work to
disk. When you’re ready to continue, select OPEN under the “File” menu to
open your file, then continue on with the next section.

USING TRACK AND OBJECT LIBRARIES

With 3D Railroad, it’s possible to add many other types of objects to your
layouts. Using the track tools as demonstrated earlier, you can access 3D
Railroad’s wide variety of manufacturer (and custom) track and symbol
libraries to build unique track layouts. You can even build custom track pieces
and create your own custom libraries if you’d like.

Using 3D Railroad
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To let you see some of the things you can do, we’ll embellish the sample oval
layout you created earlier with some scenery and other symbols. You’ll end up
with a finished layout that will look something like this.

1. ADD A LIBRARY  SYMBOL .

• Click the GET OBJECT FROM LIBRARY button, or select GET OBJECT

FROM LIBRARY under the “Tools” menu.

• If you took a break after the last tutorial section, you will have to
reopen the Tutorial library. Refer to Step #8 in your last session.

• Click the symbol named “Cambria Boiler Works”

• Click the ADD TO PLAN button, then the “Ok” button. The symbol
appears near the center of the drawing window.

• Move onto the symbol and drag it into position just below the spur/
bumper. (See the preceding illustration)

2. CONTINUE  ADDING  SYMBOLS.

• Repeat the process in Step #1 until you’ve added all the library
symbols to the sample layout. Or feel free to play and arrange symbols
the way you prefer. Note: If your layout is complex, you may
experience long delays when you are editing. You can dramatically
improve performance by closing the 3D window while you are
working in the 2D window.

Note: You may need to rotate some symbols to achieve the correct
orientation. (e.g. The ADM Grain Elevator needs to be rotated 90° to the
left.) To accomplish this, you can either:

• Select a ROTATE item under the “Arrange” menu.

• Drag the “+” rotation handle that appears at the lower left corner of
objects/symbols
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• Click the desired rotate tool button. Note: For specifics about all menu
and toolbar items, refer to the What Are All Those Menus and Buttons?
section of this manual.

You can see how easy it is to enhance your plans. Feel free to experiment and
“play with” the hundreds of ready-made symbols that have been provided for
your convenience.

ABOUT THE SYMBOL LIBRARIES

For consistency, all of the symbols are provided in the HO train scale. However,
some of the provided symbols may not actually be available in HO scale and
may have been scaled from other train scales into HO scale. Refer to the
following subsection, RESIZING SYMBOLS, for instructions on resizing symbols
for use in other train scales.

In some cases, manufacturers only supply symbols for specific train scales, or a
symbol may not be available in all train scales. Please check with the manu-
facturer to be certain a particular symbol is available in a specific train scale.

You can also review MANUFACTURER PARTS LIST under the “Reports” menu
to determine what symbols are available for a particular train scale. The scale
information should be correct but pricing information is subject to change.
Price lists were provided by the manufacturers and were included with the
application as a service to 3D Railroad customers. Please contact the manu-
facturers directly regarding current prices, updates or materials questions you
might have.

For your convenience, a list of manufacturers and phone numbers is provided in
the General Information section of this manual, and can also be accessed from
CREDITS under the “Apple” menu.

RESIZING GROUPED SYMBOLS

If you are creating a layout in a train scale other than the HO scale, you can
resize symbols to the desired scale/size.

Using 3D Railroad
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For scales other than HO, change a symbol’s train scale properties to auto-size
it, or size it manually as follows. For your convenience, here is a list of the
standard train scale ratios.

Train Scale Ratio

1 1:12
3/4 1:16
G 1:22.5
17/32 1:22.6
1/2 1:24
3/8 1:32
O17 1:45.2
O 1:48
On3 1:48
On2 1:48
S 1:64
Sn3 1:64
OO 1:76.2
HO 1:87.1
HOn3 1:87.1
HOn2 1.87.1
N 1:160
Nn3 1:160
Z 1:220

Since all of the symbols are provided in HO scale, you need only divide the HO
ratio of the desired train scale, then multiply the width of the symbol by the
result to determine the new width. Since the symbol’s proportion is maintained
when you resize it, you need not be concerned about it’s height. To determine
the width of a symbol, select it with the selector tool. The width appears in the
status bar at the bottom of the window.

For example, to resize a 10" wide symbol to N train scale:

• Using the above ratios, divide the HO ratio by the N ratio to get the scale
factor: 87.1 / 160 = 0.544.

• Multiply the symbol width by the scale factor to get the new size: 10 X
0.5444 = 5.44.
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Then, it’s simply a matter of resizing the 10” symbol to the new size of 5.44"
like you would any other grouped object. To increase precision when resizing or
drawing, you can zoom in on your drawing. If you achieve an accuracy within
hundredths of an inch, this is highly accurate and more than adequate. The
result of any greater accuracy is negligible due to limitations of typical monitor
and printer resolutions, so there’s no need for concern if you are having
difficulty making the decimal value comes out exactly the same as your
calculations. Just go with the closest match.

To resize a grouped symbol/object:

1. Select the symbol.

2. Click on the hollow square handle (unfilled box) at the upper right corner.

3. Drag the resulting outline to the desired size.

“PLACE HOLDER” SYMBOLS

It’s possible to use a symbol in your layout that isn’t currently provided with
the program.

1. Choose a reasonably close match from the provided symbols.

2. Set the reports/database information for the symbol you want represented.

This “place holder” works for planning purposes, and the database information
will appear in shopping lists and other reports.

Using 3D Railroad
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PUT SELECTION IN LIBRARY

To put a selection in the library, select Put Selection in Library by clicking on its
menu item or toolbar icon.

     

• If you’ve previously opened a library, either by using PUT SELECTION INTO

LIBRARY or GET OBJECT FROM LIBRARY, any selected objects are
automatically put into the current library. Use GET OBJECT FROM LIBRARY

to change the current library. If no library has been specified, an OPEN file
dialog appears.

There are several areas to this dialog box. Refer to OPEN FILE DIALOG

information in “Properties Dialog Boxes” in the What Are the Basics?
section of this manual for more specific information.

• Type the name you want to use to file your selection into the File name box
at the bottom of the dialog box.

• Click OPEN in the lower right corner of dialog box. A box appears with the
message, “This selection was added to the … library.”
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TAKING A VIRTUAL 3D WALK-AROUND

How would you like to take a virtual 3D walk around the sample plan you’ve
created? Well, let’s go!

Select SHOW 3D VIEW by clicking on its View menu item or Toolbar icon, or
by using its key command.

 

 

A window opens showing the 3D View for the sample layout.

Note: To display more objects on your 3D view, you must first place them on
your 2D plan.

To move around in the 3D view: There will be times you want to move around
the 3D window. There are several ways to do this:

1. Use the movement arrows on the Toolbar.

2. Move your mouse pointer onto the 3D screen and hold the mouse button
down. Note: You will probably notice a shift in the view as soon as you press
the mouse button down.

3. Use the PAGE UP and PAGE DOWN keys.

Using 3D Railroad
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Turn Left: Use LEFT arrow or drag the pointer left.

Turn Right: Use RIGHT arrow or drag the pointer right.

Move Closer: Use UP arrow or drag the pointer up.

Move Away: Use DOWN arrow or drag the pointer down.

Move Up: Use SHIFT+UP arrow, use SHIFT while moving the pointer, or use the
PAGE UP key.

Move Down: Use SHIFT+DOWN arrow, use SHIFT while moving the pointer, or
use the PAGE DOWN key.

Move Left: Use SHIFT+LEFT arrow or use SHIFT while moving the pointer.

Move Right: Use SHIFT+RIGHT arrow or use SHIFT while moving the pointer.

Move Faster: Drag the Arrow pointer farther from center.

Tilt Forward: Use CMD+UP arrow.

Tilt Backward: Use CMD+DOWN arrow.

Tilt Left: Use CMD+LEFT arrow.

Tilt Right: Use CMD+RIGHT arrow.

Look Up/Down: USE THE LOOK DOWN arrow or hold CMD down while
pressing the mouse button.

RUNNING A TEST TRAIN

To place train:

1. Select RUN TEST TRAIN by clicking on either the Tools menu item or on its
icon on the Toolbar while in the 2D view.
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2. Click the desired location on your plan. The “Train Properties” dialog box
will automatically open.

   

To set train properties:

Train Object:  Click Browse to use a different 3D train locomotive object.

Car Object: Click Browse to use a different train-car object.

Train Speed: Move slider or click on the arrows to set the speed.

Car Count:  Move slider or click on the arrows to set car count.

Color on 2D: Sets the color of the 2D train objects. Click on the color
bar and the Color dialog box opens automatically. Refer to the “Using
Colors and Patterns” in the What Are the Basics? section of this
manual for more specific information.

Train Status: Once your test train is running, whenever it encounters a
bad section of track and stops, this box will identify the problem with
your track layout. To set testing parameters:

•. Select PREFERENCES from the “Options” Menu.

• Select the Train tab.

Sets the maximums for five track measurements.

Using 3D Railroad
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• Maximum distance between track connections. If the distance between
two pieces of track is greater than this distance, the test train will stop.
Otherwise it will jump the gap and continue running.

• Maximum elevation gap between connections. If the elevation dif-
ference between connected track is greater than this, the train will stop.

• Maximum grade percentage. If the grade of any track is greater than
this, the test train will stop.

• Maximum angle between track connections. If a track connection
results in an angle greater than this, the test train will stop.

• Maximum track bend deformation (0.0 – 1.0)  This value determines
the maximum amount the spline and curved track can bend before it’s
considered invalid. The greater the value, the greater the allowable
bend. You will probably want to work with values between 0.01 and
0.10 for testing layouts. For example, a setting of 0.05 causes the test
train to be more sensitive to sharper bends/curves.

3. Use mouse button to drag the train to the desired track location.

4. Click on the test-train engine (marked by line in center of car) with the
mouse button to run test train on track, reverse direction or drag the train to a
new location. Whenever the test train stops, select Properties to determine
the reason. To stop the train choose “Stop test train” from the “Tools” pull
down menu.

5. To delete the test train, hold the “Control” key and select the train. Choose
“Delete” from the pop-up menu.

CREATING CUSTOM BENCHWORK

The 3D Railroad benchwork represents a tabletop… sheet of plywood… any
surface your layout will rest upon. In the 2D view of your layout, the
benchwork will appear as a simple form (polygon, rectangle, etc.). However, in
the 3D version, it takes on life! It becomes whatever you choose — grass, rock,
sand, etc. — in an almost endless variety … the possibilities are wide open.
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INSERT BENCHWORK

Select Insert BENCHWORK by clicking on its menu item or Toolbar icon.

  

An icon resembling a table appears to be used to define the benchwork area.
Clicking on one of the benchwork lines allows you to select “Properties” for the
benchwork.

Benchwork Properties Dialog Box displays two(2) tabs, Line and Benchwork.
There is a large selection of special benchwork textures such as grass, sand,
dirt, wood grains, etc. (Refer to Insert Benchwork in the What Are All Those
Menus and Buttons? and PROPERTIES DIALOG BOX in the What Are the
Basics? section of this manual for more specific information.)

     

CREATING ACCURATE TURNOUTS/SWITCHES

Having exact end-point locations and angles is of key importance when creating
turnouts, especially ready-made turnouts. Measure all turnout angles carefully,
as this is the most likely place for error. And, remember, as long as the end
points and angles are correct, they will allow connecting other track correctly

Using 3D Railroad
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and will match what you purchase. (Refer to CREATING A SAMPLE TURNOUT /
SWITCH earlier in this section for more information.)

SETTING THE 3D BACKDROP
If you would like to use something other than the default backdrop, clicking on
BROWSE on the 3D View Tab under Preferences in the “Options” menu will
open the “Backdrop” folder for you to select a different backdrop. There are
several areas to this dialog box. For more specific information, refer to the
OPEN FILE DIALOG information on the Open file dialog, under the “Properties
Dialog Boxes” in the What Are the Basics? section of this manual.

CREATING SYMBOL LIBRARIES

Symbol libraries can be made up of any combination of:

• Single track pieces drawn with the track tools.

• Grouped track objects (e.g., switches, crossings, etc.).

• Single or grouped objects drawn with the drawing tools.

• 2D bitmaps or 3D masked bitmaps

• 3D Studio or DXF objects imported/inserted with the insert tool.

• Various combinations of the above.

TO OPEN AN EXISTING LIBRARY, OR CREATE A NEW LIBRARY

1. Select GET OBJECT from Library under the “Tools” menu, or click its
Toolbar icon and the Library properties dialog box opens.

2. Click OPEN.

3. For a new library, click NEW:

• Type the name of your new library in the filename box.

• Click OPEN. Note: It’s best to use the default file name extension, “RRL”.

This creates a new empty library.
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To add to an existing library:

• Click its name, then click OPEN.

4. Click “OK” to exit the library dialog.

The new library, or existing library, now becomes the current working library. If
you select PUT SELECTION INTO LIBRARY, the selected objects will be placed
into this new library.

TO CREATE A 2D LIBRARY SYMBOL AND ADD IT TO A LIBRARY

1. Use the drawing or track tools to draw the desired library symbol. Note: It
can be a single or grouped object.

2. Select the object and open its PROPERTIES DIALOG box.

3. Set any reports or other properties as desired.

4. Use the Selector arrow to select the symbol.

5. Click on PUT SELECTION INTO LIBRARY under the “Tools” menu or its
toolbar icon, and the object is added to the current working library. Note:
You can select and add more than one object at a time.

TO CREATE A 3D-LINKED BITMAP OR 3D-LINKED OBJECT AND ADD IT TO A LIBRARY

1. Select INSERT 3D BITMAP  by clicking on its menu item or Toolbar icon.
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An icon resembling a tree appears to be used to define a rectangular area (an
“X” box) that will hold the 3D bitmap. A 3D Bitmap properties dialog box
will appear.

Click BROWSE then OPEN the file for the object you want to import. Note:
The object displays in the preview area.

2. Set the reports properties. The reports information will appear in material
reports, and will be used to list objects when you later access them in library
dialog. Note: If you plan to draw a top view of the object, you can specify
the reports information in Step #4. Otherwise, specify the information now.
Pre-read Steps #3 and #4.

3. Set the “Hide cross reference box when object is grouped” option. You
can draw a top view representation of the object using the drawing tools (as
was done with the provided symbol libraries) or you can let the “X” box you
created represent the object on the top view.

If you draw a top view object:

• Make sure the “Hide cross reference box when object is grouped”
option is checked (enabled).

• After drawing the top view object, group it with the “X” box. The X
box will disappear, leaving only your top view object visible.

• Click “OK” to exit the properties dialog. Note: If a 3D view of your
layout is open, the object will appear in the 3D view as well.

For further information, refer to the 2D PROPERTIES DIALOG BOX under
“Properties Dialog Boxes” in the What Are the Basics? section of this manual.

4. Draw the top view if preferred. If you want to create a custom top view
representation of the object.

• Draw the top view object, group it, then position it on top of the “X”
box, and select GROUP.

• If you perform this step, click the final grouped object and set the
reports properties for the group.

• Also set the “Fixed” pricing option to indicate you want the specified
price to represent the entire group rather than a price “Automatically”
being calculated based on the group’s component object prices.
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5. Select the final symbol using the Selector, then select the PUT SELECTION

INTO LIBRARY menu item, or its toolbar icon. The object is added to the
current working library.

Once you’ve added objects to libraries, you can place them in your railroad plans
by clicking the GET OBJECT FROM LIBRARY menu item or its toolbar icon.

Using 3D Railroad
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WHAT ARE ALL THOSE MENUS AND BUTTONS?
The majority of objects drawn or manipulated by the menu items or the Toolbar
buttons have a “Properties Dialog Box” that is used to set a wide-range of
characteristics/attributes for the object. While a number of these dialogs are
specific to one particular object, most of them are more generic and are used for
several different objects.

In order to avoid repeating the same information over and over, we have placed
that material under “Properties Dialog Boxes” in the What Are the Basics?
section of this manual. If the object you’re working with has one of these more
generic dialog boxes, you will be referred to that area for more specific
information.

MAIN MENU
The strip at the top of the screen is called the “Main Menu.” The words on it —
“File,” “Edit,” “Tools,” “View,” “Arrange,” “Reports,” “Options,” and “Help” —
represent menus of commands. To open a menu, place the Selector on the word
for the menu item and press the mouse button.

Main Menu items open pull-down windows that contain commands.

• Commands followed by an ellipsis ( … ) means there is an additional
subwindow with special options or instructions.

• Dimmed (gray text instead of black) means a command cannot be selected.

• Some commands are followed by a combination of keys (e.g. Cmd+N).
These are called keyboard shortcuts and are alternatives to using the Mouse.
Note: Do not press the + sign, just press the two keys indicated.
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“FILE” MENU ITEMS

The File Menu contains the commands: NEW, OPEN, CLOSE, SAVE, SAVE AS...,
REVERT, SAVE 3D VIEW…, DOCUMENT SETUP, PAGE SETUP, PRINT

PREVIEW, PRINT, PRINT 3D VIEW, RECENT FILE And QUIT.

NEW (CMD+N)
Opens a new drawing window and assigns it the name “Untitled.” Use this
command to begin a new railroad plan.

OPEN (CMD+O)
Opens an existing railroad plan.

• Click the OPEN button.

• When the dialog box appears, make your selection from the File Name box.

Menus and Buttons
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• Click OK in the lower right corner of dialog box or double-click on the file.

CLOSE

Closes current plan.

SAVE (CMD+S)
“SAVE” saves a plan as a disk file using its current name.

SAVE AS

“SAVE AS…” allows you to name a new plan, save the current plan under a
different name or replace an existing plan with the current one.

• Click SAVE AS button.

• When the dialog box appears, type the plan name in the File Name box.

• Click “Save.” Note: If you’ve already named your plan, no dialog appears.
Your plan is saved again using the same name.
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DOCUMENT SETUP

Sets the Document Size, View Scale, Orientation, Print Scale and Print
Preferences for your plan.

Document Size: Sets the height and width of your plan. Note: The default
setting is “inches, decimal” To change to another measurement:

• Select “Options” on the Main Menu Bar.

• Select “Preferences” from the pull-down window.

• Click the triangle to the right of the “Unit” entry in the dialog box, under the
“Metrics and grid” tab.

• Select your preferred measurement.

• Click “OK” in the dialog box and return to “Document Setup.”

View Scale: Sets the size objects appear on your screen — the lower the
number, the larger the objects will appear.

PAGE SETUP

Selects the printer name, paper and orientation for your plan. The actual print
options may vary depending on the printer and drivers you have. Here are

Menus and Buttons
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examples of what you might see. Please refer to your user guides for your
printer and Macintosh for more detailed information.

Printer Name: Selects the printer or output destination. (Your current printer
will be listed.) Note: You could also select outputting to a fax.

Page Attributes:

Main: Might include options for choosing whether you want quality vs
speed, what media type, and what level of final output copy you want, e.g.
360 dpi or photo quality.

Paper: Sets the number of copies, paper size and paper source; printable
area; and printing orientation.

Orientation:  Sets the printing orientation of the paper. (Portrait = tall;
Landscape = wide).

PRINT PREVIEW

Lets you view —prior to actual printing — how your plan will print.

Click ZOOM IN to enlarge the view and, should you want to enlarge the view
more, reclick ZOOM IN.

Click Zoom Out to reduce the view.

Click on CANCEL to return to your plan.

If you’re satisfied and want to print the plan, click on PRINT. Note: The Print
Dialog Box automatically appears when you click on PRINT. Refer to the
following instructions to fill out the dialog box and complete printing.
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PRINT (CMD+P)
The Print Dialog sets the Printer Name, Properties, Print to File setting, Print
Range and Copies; and prints the current plan.

Printer: Selects the printer or output destination. (Your current printer is
listed.)

Destination: Gives you the choice of printing to a printer or sending the file to
a disk.

Pages: Sets which pages, or range of pages, to print.

Copies: Sets the number of copies to print and whether they should be collated.

Clicking “OK” begins printing.

PRINT 3D VIEW

Prints a copy of the current 3D view of your plan. Note: The 3D view must be
the front window.

The Print Dialog sets the Printer Name, Properties, Print to File setting, Print
Range and Copies; and prints the current plan.

Name: Selects the printer or output destination. (Your current printer is listed.)

Properties: Opens a dialog window with two tab screen choices, Paper or
Graphics.

Paper: Sets the number of copies, paper size and paper source; and reiterates
the printing orientation.

Graphics: Sets the number of dots per inch, grayscale/halftone, and darkness
for graphics.

Print to file:  Allows you to print to a disk file rather than a printer.

Print range: Sets which pages, or range of pages, to print.

Copies: Sets the number of copies to print and whether the copies should be
collated.

Menus and Buttons
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Clicking “OK” begins printing.

QUIT

Closes the plan you’re working on and exits 3D Railroad. If you have not saved
changes you’ve made to the plan, a dialog box asking if you want to save the
changes will appear.

“EDIT” MENU ITEMS

The “Edit” Menu contains the commands: UNDO, CUT, COPY, PASTE, CLEAR,
DUPLICATE, SELECT ALL,PROPERTIES AND GET LOST OBJECTS. Most
commands work with objects or text you’ve selected. Note: If the commands
are dimmed, you have not selected an object or text to edit.

UNDO (CMD+Z)
Reverses the last operation you performed. Note: You should use this command
immediately after making a mistake to ensure it will work … it might not be
available for subsequent operations you perform. However, in many cases you
can select it repeatedly to perform multiple undos.
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CUT (CMD+X)
Removes selected object(s) or text and places it on the clipboard. To CUT an
object or text:

1. Choose the Selector tool.

2. Click the object(s) you want to remove.

3. Choose CUT. Note: You can also use the keyboard by holding down the
command key while pressing the letter “X.”

COPY (CMD+C)
Copies selected objects or text and places them on the clipboard. To COPY an
object or text:

1. Choose the Selector tool.

2. Click the object(s) you want to copy.

3. Choose COPY. Note: You can also use the keyboard by holding down the
command key while pressing the letter “C.”

PASTE (CMD+V)
Pastes selected object(s) or text from the clipboard onto your plan. To PASTE an
object or text:

1. Choose the Selector tool.

2. Choose PASTE. Note: You can also use the keyboard by holding down the
command key while pressing the letter “V.”

3. The pasted object will appear and can easily be moved to the desired
position with the Selector tool.

Note: Since a copy remains on the clipboard, you can continue to paste
additional copies by repeating the PASTE command.

DUPLICATE (CMD+D)
By duplicating selected objects or text, this performs — in one operation — the
equivalent of a COPY and PASTE. To DUPLICATE an object or text:

Menus and Buttons
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1. Choose the Selector tool.

2. Click the object(s) you want to duplicate.

3. Choose DUPLICATE. Note: You can also use the keyboard by holding down
the CMD key while pressing the letter “D.”

SELECT ALL (CMD+A)
Selects all objects and text on your plan.

There are two other ways to select all objects on your plan:

• Keyboard: Hold down the Cmd key while pressing the letter “A.”

• Mouse:

A. Place your Mouse in the extreme upper corner of your plan.

B. Hold the mouse button while dragging the Mouse across your plan to
the lower right corner. This selects all the objects on your plan.

C. Release mouse button.

You can now manipulate — move, copy, cut or clear — all the objects at once.
To deSELECT, click any unselected place on the plan.

PROPERTIES

Displays the Properties Dialog Box for the selected object. The type of
information in the box varies depending upon the kind of object you’ve
selected. Note: You may select and view information for only one object at a
time: PROPERTIES is dimmed and unavailable otherwise. PROPERTIES can also
be accessed at any time by holding the control key down and selecting objects
or text. Refer to “Properties Dialog Boxes” in the What Are the Basics? section
of this manual for more specific information.

“TOOLS” MENU ITEMS

Tools are your main drawing aids. The Tools Menu contains: RUN TEST TRAIN,
STOP ALL  TRAINS, SET CAMERA POSITION, ROTATE AROUND ORIGIN,
SELECTOR, DRAW, TRACK, DIMENSION, INSERT AND LIBRARY. Note: There is
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a direct relationship between the Tools Menu items and their corresponding
icons on the Toolbar … You can access a tool by choosing it in either place.

RUN TEST TRAIN

Creates a train for testing basic layout operation. To place train:

1. Select RUN TEST TRAIN by clicking on either the Tools menu item or on its
icon on the Toolbar.

   

2. Click the desired location on your plan. The “Train Properties” dialog box
will automatically open.

Menus and Buttons
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To set train properties:

Train Object:  Click Browse to use a different train locomotive object.

Car Object: Click Browse to use a different train-car object.

Train Speed: Move slider or click on the arrows to set the speed.

Car Count:  Move slider or click on the arrows to set car count.

Color on 2D: Sets the color of the 2D train objects. Click on the color
bar and the Color dialog box opens automatically. Refer to the “Using
Colors and Patterns” in the What Are the Basics? section of this
manual for more specific information.

Train Status: Once your test train is running, whenever it encounters a
bad section of track and stops, this box will identify the problem with
your track layout. To set testing parameters:

•. Select PREFERENCES from the “Options” Menu.

• Select the “Train” tab.

• Complete settings for maximum distance between track
connections, elevation gap between connections, grade, angle
between track connections, and track bend deformation.

3. Use mouse button to drag the train to the desired track location.

4. Click on the test-train engine (marked by line in center of car) with the
mouse button to run test train on track, reverse direction or drag the train to a
new location. Note: To change test-train properties or to check train status,
click while holding the control key.

5. To delete the test train, use the Right Mouse-Button to click the train and
select DELETE from the pop-up menu.

SET CAMERA POSITION

Creates 2D cameras for controlling the 3D-view perspective.
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1. Select SET CAMERA POSITION by clicking on either the Tools menu item or
on its icon on the Toolbar..

   

2. Click desired location on plan.

3. Click and hold down mouse button to drag camera around your plan.

4. Drag handles to reshape camera size, or lens and view angle, or to rotate.

5. Click while holding control to select PROPERTIES. Properties sets line style,
width and color; report fields; and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information.

TO CHANGE ANGLE  OF CAMERA  VIEW

• The hollow circle at the top of the camera base lets you adjust the size of the
2D camera without affecting the 3D view.

Menus and Buttons
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• The hollow circle at the top of the lens controls the camera lens or view
angle and lets you zoom in but see a smaller area, or the reverse.

• The hollow circle at the center of the lens has no affect on 3D view but lets
you adjust the size of the 2D camera lens control

ROTATE AROUND ORIGIN

Rotates selected objects around a clicked origin point.

1. Select ROTATE AROUND ORIGIN by clicking on either the Tools menu item
or on its icon on the Toolbar.

   

2. Click desired location on plan. Note: An object must be selected prior to
clicking on ROTATE AROUND ORIGIN.

3. Click and hold down mouse button to rotate the object around the clicked
origin point. Note: The origin point does not have to touch or even be near
the select object.

SELECTOR

The Selector tool looks and acts like a pointer or arrow and is essential for
working on your plan.
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Click on SELECTOR in the Tools menu or on its icon on the Toolbar

   

To use the Selector: Move the tip of the Selector arrow over the object you
want to select and click. Small black squares, called handles, will appear when
the object is selected.

You can now manipulate — move, resize, copy, cut, etc. — the object. To
deselect, click on any unselected place on the plan.

To select multiple objects: Hold down the Shift key as you point and click on
each additional object. Note: Another option is to:

1. Place your Mouse beyond the edge of all the objects you want to select.

2. Hold down the mouse button while dragging the Mouse across the objects.
All objects touched by the resulting dashed-line box will be selected.

3. Release mouse button.

Refer to the “Selecting, Resizing, and Altering Objects” in the What Are the
Basics? section of this manual for more specific information.

DRAW SUB-MENU

The Draw palette includes SKETCH, LINE, BOX, ROUND BOX, ARC, OVAL

POLYGON, SPLINE AND TEXT. Each of these commands has a corresponding
icon on the Toolbar.

SKETCH

Draws a “freehand” line or object.
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Select SKETCH by clicking on its menu item or on its Toolbar icon.

  

A pencil appears and is used to draw “free form” lines. When you draw the line
you will notice several things:

• A Status Box appears that tracks the length and width of the square area the
line has covered.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the length and width of the square area the line has covered.

• When you release the mouse, square, black handles appear at each corner of
the area the line has covered. Use these handles to resize the area.

• A “+” sign appears at the lower left of the area selected. Clicking on this “+”
allows you to rotate the area around its center point. Note: The Status Box
and Bar now also reflect the angle change of the area.

Properties: Sets line width and color; To access Properties:
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1. Click while holding control to select PROPERTIES. Properties sets line width
and color; report fields; and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill appears.

.

LINE

Draws a line between two points.

Select LINE by clicking on either its Draw menu item or its Toolbar icon.

  

A pencil appears on your plan and is used to draw straight lines.
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As you draw a line you will notice several things:

• A Status Box appears that tracks the line’s length and angle.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the line’s length and angle.

• When you release the mouse, hollow circles appear at each end of the line.
Dragging on these circles allows you to lengthen the line.

• A “+” sign appears at the line’s originating point. Clicking on this “+” allows
you to rotate the line around its center point. Note: The Status Box and Bar
now also reflect the angle change of the line.

Click while holding the control key to select PROPERTIES. Properties sets line
width and color; report fields; and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics? section
of this manual for more specific information.

BOX AND OVAL

These tools are used to draw rectangles/squares and ovals/circles.

Select either of these tools by clicking on their menu item or Toolbar icon.

     

A pencil appears on your plan window and is used to draw the shapes.
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As you draw these shapes you will notice several things:

• A Status Box appears that tracks the shape’s width and height.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the shape’s width and height.

• When you release the mouse, square, black handles appear at each corner of
the shape. Use these handles to resize the shape.

  
• A “+” sign appears at the lower-left handle of the shape. Clicking on this “+”

allows you to rotate the shape around its center point. Note: The Status Box
and Bar now also reflect the angle change of the shape.

•. Click while holding control to select PROPERTIES. Properties sets line style,
width and color; report fields; and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill appears. .

Menus and Buttons
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ROUND BOX

Draws a rectangle/square box with rounded corners.

Select ROUND BOX by clicking on its Draw menu item or its Toolbar icon.

  

A pencil appears on your plan window and is used to draw a round box.

As you draw the box you will notice several things:

• A Status Box appears that tracks the box’s width and height.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the box’s width and height.

• When you release the mouse, black squares called handles appear at each
corner of the box. Use these handles to resize the shape.

• Two(2) hollow circles also appear at each corner. Click on and move these to
alter the shape of the box’s corner.

• A “+” sign appears at the lower-left handle of the box. Clicking on this “+”
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allows you to rotate the box around its center point. Note: The Status Box
and Bar now also reflect the angle change of the box.

•. Click while holding the control key to select PROPERTIES. Properties sets
line style, width and color; report fields; and settings commands. Refer to 2D
OBJECT PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information. A dialog
window with two tab screen choices, Line and Fill appears.

ARC

This tool is used to draw arcs on your plan.

  

A pencil appears on your plan window and is used to draw the arc.

As you draw the arc you will notice several things:

• A Status Box appears that tracks the arc’s width and height (2 radii).

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the arc’s width and height (2 radii), as well as the current location of
the Selector.

• When you release the mouse, square, black handles appear at the corners of
the selected arc. Use these handles to resize the arc.
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• Although, they are difficult to see, when you release the mouse, hollow
circles also appear at the ends of the selected arc. Use these circles to
lengthen and continue the arc. Note: The Status Bar now tracks the length
and radius of the arc.

• A “+” sign appears at the lower-left corner of the selected area. Clicking on
this “+” sign allows you to rotate the area around its center point. Note: The
Status Box and Bar now also reflect the angle change of the arc.

•. Click while holding the control key to select PROPERTIES. Properties sets
line width and color; report fields; and settings commands. Refer to 2D
OBJECT PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information. A dialog
window with two tab screen choices, Line and Fill appears. .

POLYGON

The polygon (from the Greek word for “many”) lets you draw a series of
connected lines to create a multiple-sided object.
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Select POLYGON by clicking on its Draw menu item or its Toolbar icon

  

A pencil to use in drawing the polygon will appear on your plan window.

To draw a polygon:

1. Click at the point you wish to start the first side of your polygon.

2. Move to the end point of the first side and click again. Note: You will notice
the line seems to be “stuck” to your pencil until you click at the corner.

3. Repeat Steps #2 & #3 until you’ve returned to the polygon’s starting point.

4. Double click on the starting point to complete the polygon.

As you draw the polygon, you will notice several things:

• A Status Box appears that tracks the total length of the line creating the
polygon, as well as showing the angle of each corner you create.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the total length of the line creating the polygon.

• When you release the mouse, square, black handles appear at each corner of
the area covered by the polygon. Use these handles to resize the polygon.
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• Hollow circles also appear at each angle of the polygon. Use these circles to
change the size of each angle and to lengthen or shorten a particular line
segment.

• A “+” sign appears at the lower-left handle of the selected area. Clicking on
this “+” allows you to rotate the area around its center point. Note: The
Status Box and Bar now also reflect the angle change of the area.

• Click while holding the control key to select PROPERTIES. Properties sets
line width and color; report fields; and settings commands. Refer to 2D
OBJECT PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information. A dialog
window with two tab screen choices, Line and Fill appears.

.

SPLINE

Lets you draw a spline-based curve from a series of connected lines.



90

Select SPLINE by clicking on either its Draw menu item or its Toolbar icon.

  

A pencil to use in drawing the spline will appear on your plan window.

To draw a spline:

1. Click at the point you wish to start your curve.

2. Move to the end point of the first segment of your curve and click. Note: You
will notice the line seems to be “stuck” to your pencil until you click at the
corner.

3. Move to the end point of the second segment of your curve and click again.
Note: You will notice that when you click an end point, the square corner
smooths into a curve.

4. Repeat Steps #3 & #4 for a series of curves.

5. Double click to complete your curve(s).

Adjusting Curves: When you release your mouse-button, two(2) hollow circles
and a square appear at each curve of the spline.

Click on one of the circles and move it to alter the shape of the curve. The hol-
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low box can also be moved along the line to change the location of the curve.
When you release the mouse, black squares called handles also appear at each
corner of the area covered by the spline. Use these handles to resize the spline.

As you draw the spline, you will notice several things:

• A Status Box appears that tracks the total length of the spline, as well as
showing the angle of each curve you create.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the total length of the spline.

• A “+” sign appears at the lower-left handle of the selected area. Clicking on
this “+” allows you to rotate the area around its center point. Note: The
Status Box and Bar now also reflect the angle change of the area.

• Click while holding the control key to select PROPERTIES. Properties sets
line width and color; report fields; and settings commands. Refer to 2D
OBJECT PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information. A dialog
window with two tab screen choices, Line and Fill appears.

TEXT

The TEXT tool lets you enter text for labels, etc.
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Select Text from its Draw menu item or its Toolbar icon.

  

A bar-shaped icon called a cursor will appear on your plan window.
To type and format text:

1. Click and drag your Mouse to define a rectangular area that will hold the text
… a Text properties dialog box will appear with a flashing bar in the upper
left of the text screen.

2. Type in your text.

3. Click on the FONT button … the Font screen will appear.

4. Set Font properties:

Font: Select font.

Text Style: Select style

Size: Select font size. Note: Sizes for your font choice will automatically
come up. You can set other sizes but the ones displayed will give you the best
printout.

Preview Window: Displays a preview of your font choices.

5. If you’re satisfied with what you’ve typed, click "OK".

Your selected text has black squares called handles at each corner of the text
area. Use these handles to resize the text area.
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Note: Manipulating the handles will not affect your text. To make changes to
your text:

1. Click on the text while holding the control key.

2. Select PROPERTIES.

3. Make your changes.

4. Click “OK.”

As you use the handles, you will notice several things:

• A Status Box appears that tracks the height and width of your text block, as
well as showing the angle of the text.

• A Status Bar appears at the bottom of your monitor screen that tracks the
height and width of your text block, as well as showing the angle of the text.

• A “+” sign appears at the lower-right handle of the selected text. Clicking on
this “+” allows you to rotate the text around its center point.

• As you change the text-box size, the text lines wrap around if it is needed for
the text to remain within the box.

“TRACK” MENU

The Track palette includes the commands: STRAIGHT TRACK, CURVE TRACK,
OVAL  TRACK And SPLINE TRACK. Each of these commands has a
corresponding icon on the Toolbar.

Each track style has its own TRACK  PROPERTIES DIALOG  BOx. Properties
dialog boxes contain the settings for Length, Radius(1), Radius(2), Start angle,
ArcDegrees, Grade %, Elevation1, Elevation2, Railspacing, Tie length, Tie
spacing, Track sep, Show axis, Show ties, Resizable option, Normal/Bridge/
Tunnel, Roadbed Width and Height, and Track and Roadbed Appearance. Refer
to TRACK PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information.
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STRAIGHT  TRACK

Draws a section of straight track.

Select STRAIGHT TRACK by clicking on its Draw menu item or its Toolbar
icon.

   

A cross-hair pointer appears on your plan window and is used to draw a section
of straight track.

As you draw the track you will notice several things:

• A Status Box appears that registers the track’s length and angle.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the track’s length, angle, elevation and grade.

• When you release the mouse, hollow circles appear at each end of the track
section.

Dragging on these circles lengthens the track.

• A “+” symbol appears at the track’s originating point. Dragging this “+”
allows you to rotate the track around its center point.

• Holding the Shift key down while drawing or resizing the straight track will
constrain it to a perfect 45° or 90° angle.
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To MOVE a section of track: Move onto the track rails and drag using the
mouse button.

Track Properties: Click while holding the control key to select PROPERTIES.
Refer to TRACK PROPERTIES under “Properties Dialog Box” in the What Are
the Basics? section of this manual for more specific information.
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CURVED TRACK

This tool is used to place curved track on your plan.

Select CURVED TRACK by clicking on its Draw menu item or its Toolbar icon.

   

A cross-hair pointer appears on your plan window and is used to draw the
curved-track section.

As you draw the curved track, you will notice several things:

• A Status Box appears that registers the track’s length and radius.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the track’s length, start angle, arc degree length (measures
counterclockwise from the start angle), radius, elevation at each end and
grade.

• When you release the mouse, hollow circles appear at each end of the track
section.

Dragging on these circles lengthens the track.

• A hollow square appears at the midpoint of the track. Dragging this square
allows you to adjust the radius size of the track. The status box once again
registers the track’s length and radius.
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• A “+” sign appears near the midpoint of the track. Dragging this “+” allows
you to rotate the track around its center point.

To MOVE a section of curved track: Move onto the track rails and drag using
the mouse button.

Track Properties: Click while holding the control key to select PROPERTIES.
Refer to TRACK PROPERTIES under “Properties Dialog Box” in the What Are
the Basics? section of this manual for more specific information.

OVAL  TRACK

Draws a section of oval track.

Select OVAL  TRACK by clicking on its Draw menu item or on its Toolbar icon.
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A cross-hair pointer appears on your plan window and is used to draw a section
of oval track.

As you draw the track you will notice several things:

• A Status Box appears that registers the track’s width and height radii.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the track’s length, start angle, arc degree length (measures
counterclockwise from the start angle), width and height radii, elevation at
each end and grade.

• When you release the mouse, hollow circles appear at each end of the track
section.

Dragging on these circles allows you to lengthen the track.

• A “+” sign appears at the track’s originating point. Clicking on this “+”
allows you to rotate the track.

To MOVE a section of track: Move onto the track rails and drag using the
mouse button.

To create a spiral helix: Refer to CREATING A SPIRAL HELIX in the What Are
The Basics? section of this manual.

Track Properties: Click while holding the control key to select PROPERTIES.
Refer to TRACK PROPERTIES under “Properties Dialog Box” in the What Are
the Basics? section of this manual for more specific information.
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SPLINE  TRACK

This tool lets you draw a spline-based section of track from a series of
connected sections. Spline track emulates the bendable flex track you can
purchase in a store. Note: You may find the spline track tool very useful to
emulate flex track, or to connect the ends of two sections of track when a
custom track piece is needed.

Select SPLINE TRACK by clicking on its Draw menu item or Toolbar icon.

   

A cross-hair pointer appears on your plan window and is used to draw a section
of spline track.

To draw a section of spline track:
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1. Click at the point you wish to start your track.

2. Move to the end point of the first segment of track and click. Note: You will
notice the track seems to be “stuck” to your icon until you click at the end
point.

3. Move to the end point of the second segment of your track and click again.
Note: You will notice that when you click an end point, the square corner
smooths into a curve.

4. Repeat Steps #3 & #4 for a series of curves. Note: You need only draw one
straight section to create a track with minimal bends to adjust (2 control
points).

5. Double click to complete your spline.

When you release the mouse, black squares called handles also appear at each
corner of the area covered by the spline. Use these handles to resize the whole
piece of track at once.

As you draw the spline, you will notice several things:

• A Status Box appears that registers the spline’s total length and the angle of
the currently drawn track section.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the spline’s length, angle, elevations and grade.

• A “+” sign appears at the lower-left handle of the selected area. Dragging
this “+” allows you to rotate the spline. Note: The Status Box now reflects
the rotation angle.

Adjusting Curves: When you release your mouse-button, two(2) hollow circles
and a square appear at each curve. Drag one of the circles to alter the shape of
the curve. The hollow box can also be moved along the track to change the
location of the curve.
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To MOVE a section of track: Move onto the track rails and drag using the
mouse button.

Track Properties: Click while holding the control key to select PROPERTIES.
Refer to TRACK PROPERTIES under “Properties Dialog Box” in the What Are
the Basics? section of this manual for more specific information.

DIMENSION SUBMENU

     You may, on occasion, need to know the size of an area or the distance between
two points; or you may want to mark a location for future reference for
positioning, drawing and aligning objects. The Dimension measuring tools will
be of assistance in such situations.

The Dimension palette includes the commands: DRAW DIMENSION LINE,
DRAW DIMENSION ANGLE, MEASURE LINE And MEASURE BOX. Each of
these commands has a corresponding icon on the Toolbar.

DRAW DIMENSION  LINE
The Dimension Line draws an editable dimension line. This line allows you to
put length dimensions on your plan to indicate the size of objects or the
distance between two points.
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Select DIMENSION LINE by clicking on its Draw menu item or its Toolbar icon,

   

You use the Selector to draw your dimension line by dragging the Selector from
the point you want to measure from, to the point you want to measure to and
then releasing the Mouse button.

As you drag the Selector you will notice several things:

• Two parallel lines, connected by a perpendicular third line appear on your
plan window.

The connecting line measures the distance between the parallel lines and is
marked by arrows at each of its ends.

• A Status Box that tracks the line’s length and angle appears next to the
Selector.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the line’s length` and angle.

• The line’s length appears next to the connecting line.

• When you release the mouse, hollow circles appear at the beginning and
ending points of the parallel lines and at the midpoint of the connecting line.
Dragging on these circles allows you to resize any of the three lines.

• A “+” sign appears at the starting point of the dimension line. Clicking on
this “+” allows you to rotate the dimension line around the midpoint of the
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connecting line. Note: The Status Box and Bar now also reflect the angle
change of the dimension line.

• As long as the dimensions line is SELECTED, THE HOLLOW circles and the
“+” remain visible. As soon as you deselect the line, they disappear, leaving
the dimension lines and the figures noting the length of the measured area.

• To reselect the line, click on either the circles or at any point along lines.

• To MOVE  the line: select it, click at any point along the line and drag the
line to its new location.

Properties Dialog Box: Select the line while holding the control key. A dialog
window appears with two tabs, Line and Frames. Refer to 2D PROPERTIES BOX

under “Properties Dialog Box” in the What Are the Basics? section of this
manual for more specific information.

DRAW DIMENSION  ANGLE

The DIMENSION ANGLE draws an editable dimension line/arc to angles. Use
this tool to indicate the angle dimensions of your plan or to measure the angle
between objects or drawing elements.
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1. Select DIMENSIONS ANGLE on the Draw menu or click on its Toolbar icon.

   

2. Click at the point you want to set your angle. Drag a protractor-shaped object
downward to measure outside angles or drag it upward to measure inside
angles. You will see:

• Two intersecting lines, connected by a curved third line near their end
points. This connecting line measures the angle of the intersecting lines
and is marked by arrows at each of its ends.

• There are also four(4) hollow circles: one at the end point of each
straight line and one at their intersection point; another circle is located
on the curved line. Use these circles to resize the line’s length and angle.

• The degree of the angle also appears near the circle on the curved line.
Note: Move the hollow circle on the curved line to adjust the position
of the angle text.

• A “+” sign also appears at the end point of the right line. Clicking on
this “+” allows you to rotate the angle around the intersection point of
the line segments. Note: The Status Box and Bar now also reflect the
rotation angle.

3. To resize the angle or straight lines, click the Selector on one of the
circles located at the end points of the lines. As you move the circles you
will notice several things:
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• A Status Box that registers the location of the angle and tracks the
angle’s degree appears next to the Selector Arrow.

• A Status Bar appears at the bottom of your monitor screen. This bar
also registers the location of the angle and tracks the angle’s degree.

4. As long as the dimension angle is SELECTED, the hollow circles and
the “+” remain visible. As soon as you deselect the angle, they disappear,
leaving the dimension angle and the register of its angle.

5. To reselect the angle, click on any circles or at any point along the lines.

To move the line: select it, click at any point along the line and drag the line to
its new location.

Properties Dialog Box: Select the line while holding the control key. A dialog
window appears with two tabs, Line and Frames. Refer to 2D PROPERTIES BOX

under “Properties Dialog Box” in the What Are the Basics? section of this
manual for more specific information.

DRAW MEASURE LINE

Select MEASURE LINE on the Draw menu or by clicking on its Toolbar icon.
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An icon resembling a ruler appears next to the Selector Arrow on your plan window.
Use the Selector Arrow to draw your measured line by dragging the Selector
from the point you want to measure from, to the point you want to measure to
and releasing the Mouse button.

As you draw the line you will notice several things:

• A Status Box appears that tracks the line’s length and angle.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the line’s length and angle.

• When you release the mouse, hollow circles appear at each end of the line.
Dragging on these circles allows you to lengthen the line.

• As long as the MEASURE LINE is selected, the hollow circles and the Status
Box figures remain visible. As soon as you deselect the line, the line and the
figures disappear, and the hollow circles are replaced by hollow squares that
mark the ends of the path of your measured line. Note: Holding down the
CMD key overrides leaving marker objects.

• To reselect the line, click on either a square or at any point along the
measured path.

• To move the measure line: select it, move on to any point along the line and
drag the line to its new location.

Note: The Properties dialog box is not of use with this measurement other than
to set the font size for the measurement text.

DRAW MEASURE BOX

The MEASURE BOX measures a rectangular area.

Select MEASURE BOX on the Draw menu or by clicking its Toolbar icon.
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An icon resembling a ruler appears next to the Selector Arrow on your plan
window. Use the Selector to draw your box by clicking at the point you want to
measure from, dragging the Mouse diagonally across the area you want to
measure and clicking the Mouse again at the opposite corner.
As you drag the Selector you will notice several things:

• A box appears that defines the area you are measuring.

• A Status Box appears that tracks the box’s length, width and area.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the box’s length, width and area.

• When you release the mouse, black squares appear at each corner of the box.
Dragging on these squares allows you to resize the box.

• As long as the box is selected the box outline and the Status Box figures
remain visible. As soon as you deselect the box, the outline and the figures
disappear, and the black squares are replaced by hollow squares. These
hollow squares mark the corners of the measured area. Note: CMD overrides
leaving marker objects.

• To reselect the box, click on either a square or at any point along the
perimeter of the measured area. The box and figures will now reappear.

• To move the measure box: select it, move on to one of the box lines, and
drag the box to its new location.

Note: The Properties dialog box is not of use with this measurement other than
to set the font size of the measurement text.
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INSERT SUBMENU

    Contains the commands: 2D BITMAP PICTURE, 3D BITMAP, 3D OBJECT and
BENCHWORK.

INSERT 2D BITMAP  PICTURE

Imports a bitmap picture (*.bmp file) and inserts it into the 2D drawing
window.

Select Insert 2D BITMAP PICTURE by clicking on its menu item or Toolbar
icon.

  

An icon resembling an eye appears to be used to define a rectangular area that
will hold the 2D picture. A Picture properties dialog box will appear.
Properties Dialog Box: Click on the line while holding the control key. A dialog
window appears with two tabs, Line and Frames. Refer to 2D PROPERTIES BOX

under “Properties Dialog Box” in the What Are the Basics? section of this
manual for more specific information.
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INSERT 3D BITMAP

Imports a bitmap picture (*.bmp file) and mask (*.msk), and inserts it into the
3D drawing window.

Select Insert 3D BITMAP by clicking on its menu item or Toolbar icon.

  

An icon resembling a tree appears to be used to define a rectangular area that
will hold the 3D bitmap. A 3D Bitmap properties dialog box will appear.
Properties Dialog Box: Refer to 3D BITMAP PROPERTIES under “Properties
Dialog Box” in the What Are the Basics? section for more specific information.
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INSERT 3D OBJECT
Imports a 3D object. (3D Studio or DXF)

Select Insert 3D OBJECT by clicking on its menu item or Toolbar icon.

  

An icon appears to be used to define a rectangular area that will hold the 3D
object. When you draw the rectangle, a 3D Objects properties dialog box appears.

3D Objects Properties Dialog Box: Refer to 3D OBJECTS PROPERTIES under
“Properties Dialog Boxes” in the What Are the Basics? section of this manual
for more specific information.
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INSERT BENCHWORK

Draws polygonal benchwork structures that appear in place of the default
benchwork in the 3D view.

Select Insert BENCHWORK by clicking on its menu item or Toolbar icon.

  

An icon resembling a table appears for drawing the benchwork. To draw a
benchwork object:
1. Move to the start point of one side of the anticipated benchwork and click.
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2. Drag the side to the desired length and click.

3. Repeat Step #2 for each side.

4. Double click to complete the object.

Your custom benchwork object(s) now replaces the default benchwork that is
based on the document size. (See DOCUMENT SETUP earlier in this section.)

Clicking on one of the benchwork lines allows you to select “Properties” for the
benchwork.

Benchwork Properties Dialog Box displays two(2) tabs, Line and Benchwork.
Refer to BENCHWORK PROPERTIES DIALOG BOX under “Properties Dialog
Box” in the What Are the Basics? section of this manual for more specific
information.

PUT SELECTION INTO LIBRARY
To put a selection in the library, select Put Selection in Library by clicking on
its menu item or Toolbar icon.

  

If you’ve previously opened a library, either by using PUT SELECTION INTO

LIBRARY or GET OBJECT FROM LIBRARY, any selected objects are automat-
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ically put into the current library. Use GET OBJECT FROM LIBRARY to change
the current library. If no library has been specified, an OPEN file dialog appears.

There are several areas to this dialog box. Refer to OPEN FILE DIALOG

information in “Properties Dialog Boxes” in the What Are the Basics? section
of this manual for more specific information.

• Click an existing library to open and add objects to it. Or, to create a new
library, type the name you want to use to file your selection into the File
name box at the bottom of the dialog box.

• Click OPEN in the lower right corner of dialog box. A box appears with the
message, “This selection was added to the … library.” (For more information,
refer to CREATING LIBRARY SYMBOLS in the “Tutorial”  section of this manual.)

GET OBJECT FROM LIBRARY

ABOUT THE SYMBOL LIBRARIES

For consistency, all of the symbols are provided in the HO train scale. However,
some of the provided symbols may not actually be available in HO scale and
may have been scaled from other train scales into HO scale.

In some cases, manufacturers only supply symbols for specific train scales, or a
symbol may not be available in all train scales. Please check with the manu-
facturer to be certain a particular symbol is available in a specific train scale.

You can also review MANUFACTURER PARTS LIST under the “Reports” menu
to determine what symbols are available for a particular train scale. The scale
information should be correct but pricing information is subject to change.
Price lists were provided by the manufacturers and were included with the
application as a service to 3D Railroad customers. Please contact the
manufacturers directly regarding current prices, updates or materials questions
you might have.

For your convenience, a list of manufacturers and phone numbers is provided in
the General Information section of this manual, and can also be accessed from
CREDITS under the “Apple” menu.

RESIZING GROUPED SYMBOLS

If you are creating a layout in a train scale other than the HO scale, you can
resize symbols to the desired scale/size.
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For scales other than HO, change a symbol’s train scale properties to auto-size
it, or size it manually as follows. For your convenience, here is a list of the
standard train scale ratios.

Train Scale Ratio

1 1:12
3/4 1:16
G 1:22.5
17/32 1:22.6
1/2 1:24
3/8 1:32
O17 1:45.2
O 1:48
On3 1:48
On2 1:48
S 1:64
Sn3 1:64
OO 1:76.2
HO 1:87.1
HOn3 1:87.1
HOn2 1.87.1
N 1:160
Nn3 1:160
Z 1:220
Since all of the symbols are provided in HO scale, you need only

divide the HO ratio of the desired train scale, then multiply the width of the
symbol by the result to determine the new width. Since the symbol’s proportion
is maintained when you resize it, you need not be concerned about its height. To
determine the width of a symbol, select it with the selector tool. The width
appears in the status bar at the bottom of the window.

For example, to resize a 10" wide symbol to N train scale:

• Using the above ratios, divide the HO ratio by the N ratio to get the scale
factor: 87.1 / 160 = 0.544.

• Multiply the symbol width by the scale factor to get the new size: 10 X
0.5444 = 5.44.

Menus and Buttons
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Then, it’s simply a matter of resizing the 10" symbol to the new size of 5.44"
like you would any other grouped object. To increase precision when resizing or
drawing, you can zoom in on your drawing. If you achieve an accuracy within
hundredths of an inch, this is highly accurate and more than adequate. The
result of any greater accuracy is negligible due to limitations of typical monitor
and printer resolutions, so there’s no need for concern if you are having
difficulty making the decimal value comes out exactly the same as your
calculations. Just go with the closest match.

To resize a grouped symbol/object:

1. Select the symbol.

2. Move onto the hollow square handle (unfilled box) at the upper right corner.

3. Drag the resulting outline to the desired size.

“PLACE  HOLDER” SYMBOLS

It’s possible to use a symbol in your layout that isn’t currently provided with
the program.

1. Choose a reasonably close match from the provided symbols.

2. Select the symbol while holding the control key.

3. Set the reports/database information according to the symbol that you want
represented.

This “place holder” works for planning purposes, and the database information
will appear in shopping lists and other reports.
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To Get a Selection From the Library

Select GET OBJECT FROM LIBRARY by clicking on its menu item or Toolbar
icon.

  

Note: If no library has been accessed previously, the OPEN FILE Dialog appears
here first, as it does with PUT SELECTION INTO LIBRARY. You can now open an
existing library, or create a new, empty library. (Selections can then be added to
the new library via PUT SELECTION INTO LIBRARY.)

The Library dialog box appears.

1. There are six tabs in this dialog box. Select the tab — TRACK, SCENERY,
STRUCTURES, ROLLING STOCK, MISCELLANEOUS, and ALL  — you are
interested in.

2. Click on the item(s) you want.

Menus and Buttons
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3. Click on ADD TO PLAN. You will return to your plan and the item(s) will
appear on both the 2D and the 3D plans.

In addition to Add to plan and “OK,” there are four other buttons at the bottom
of the dialog box:

Open: Opens a different library or creates a new library. Click OPEN, specify
the library’s name in the File name box, and click OPEN. Use PUT SELECTION

INTO LIBRARY to add objects to the newly created, empty library.

New: Creates a new library.

Print:  Prints the contents of the current category tab. Note: Click the All tab to
view and print all items in the library.

Properties: Displays the properties of the selected item.

Add to plan: This will place the selected item on the layout.

Delete: Deletes an item from the library.

Ok:  Exits from the library back to the layout.

“VIEW” MENU ITEMS

Contains the commands 3D View, Zoom In, Zoom Out, Normal Zoom, Fit To
Screen, Grid, Status Bar, Object Sizes and Tool Bars…

3D VIEW
Contains the commands: Show 3D View, Show 3D as Wireframe, Reset
Camera, Birds-Eye View, Left Side View, Right Side View, Front View, Back
View, Lighten and Darken.
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SHOW 3D VIEW

Automatically creates and displays a 3D view of your current drawing.

Select SHOW 3D VIEW by clicking on its View menu item or Toolbar icon, or
by using its Toolbar icon.

 

 

The 3D view will display a backdrop, benchwork, and any tracks and other
objects you have already placed on your 2D plan. Note: To display more
objects on your 3D view, you must first place them on your 2D plan. For more
control over what appears in the 3D view, use multiple layers since objects on
hidden layers do not appear in the 3D view. This is particularly useful on slower
systems because it gives faster display updates. (For more specific information
on layers, refer to Working With Layers later in this section.)

To move around in the 3D view: There will be times you want to move around
the 3D window. There are several ways to do this:

1. Use the movement arrows on the Toolbar.

2. Move your mouse pointer onto the 3D screen and hold the mouse button
down. Note: You will probably notice a shift in the view as soon as you press
the mouse button down.

3. Use the PAGE UP and PAGE DOWN keys.

Your options:

• Turn Left: Use LEFT arrow or drag the pointer left.

Menus and Buttons
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• Turn Right: Use RIGHT arrow or drag the pointer right.

• Move Closer: Use UP arrow or drag the pointer up.

• Move Away: Use DOWN arrow or drag the pointer down.

• Move Up: Use SHIFT+UP arrow, use SHIFT while moving the pointer, or use
the PAGE UP key.

• Move Down: Use SHIFT+DOWN arrow, use SHIFT while moving the pointer,
or use the PAGE DOWN key.

• Move Left: Use SHIFT+LEFT arrow or use SHIFT while moving the pointer.

• Move Right: Use SHIFT+RIGHT arrow or use SHIFT while moving the
pointer.

• Move Faster: Drag the Arrow pointer farther from center.

• Tilt Forward: Use OPTION+UP arrow.

• Tilt Backward: Use OPTION+DOWN arrow.

• Tilt Left: Use OPTION+LEFT arrow.

• Tilt Right: Use OPTION+RIGHT arrow.

• Look Up/Down: USE THE LOOK DOWN arrow or hold OPTION down while
pressing the mouse button.

SHOW 3D AS WIREFRAME

Automatically shows objects on your 3D view as wire-frame images. Note: On
slower systems, this will let you walk around the 3D view more quickly.
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Select SHOW 3D AS WIREFRAME by clicking on its menu item or Toolbar icon.

 

 

Note: To return to a solid 3D view of your objects, reclick the Show 3D As
Wireframe, and click on either its menu selection or on its Toolbar icon.

RESET CAMERA

Resets camera in the 3D view.

Select RESET CAMERA by clicking on its View menu item or Toolbar icon.

 

 

Note: Click 2D camera objects to switch 3D views to the clicked camera.

BIRDS-EYE VIEW
Sets the camera to give an overhead or “birds-eye” view of your 3D plan.

Select BIRDS-EYE VIEW by clicking on its View menu item or Toolbar icon.

Menus and Buttons



121
3D Railroad

 

 

LEFT-SIDE VIEW

Sets the camera to give a left-side view of your 3D plan.

Select LEFT-SIDE VIEW by clicking on its View menu item or Toolbar icon.
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RIGHT  SIDE VIEW

Sets the camera to give a right-side view of your 3D plan.

Select RIGHT-SIDE VIEW by clicking on its View menu item or Toolbar icon.

     

FRONT VIEW

Sets the camera to give a front view of your 3D plan.

Select FRONT VIEW by clicking on its View menu item or Toolbar icon.
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BACK  VIEW

Sets the camera to give a back view of your 3D plan.

Select BACK VIEW by clicking on its View menu item or Toolbar icon.

     

LIGHTEN

Lightens 3D view.

Select LIGHTEN by clicking on its View menu item or Toolbar icon.

     

DARKEN

Darkens 3D view.
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Select DARKEN by clicking on its View menu item or Toolbar icon.

     

ZOOM IN (CMD+PGUP)
Lets you “zoom” in on a plan to magnify/enlarge it for detailed editing.
Zooming in provides a greater degree of control and precision for fine-tuning
positions and object sizes.

Select ZOOM IN by clicking on its View menu item or Toolbar icon, or by using
its key command. Note: If you use the Toolbar icon, you must then click on
your plan to perform the zoom.

 

 

ZOOM OUT (CMD+PGDN)
Lets you “zoom” out to reduce a plan and lets you see and work with more of
the plan at one time.
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Select ZOOM IN by clicking on its View menu item or Toolbar icon, or by using
its key command. Note: If you use the Toolbar icon, you must then click on
your plan to perform the zoom.

 

 

NORMAL ZOOM (CMD+HOME)

Returns plan to its normal size.
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FIT TO SCREEN
Allows you to see your whole plan at once by reducing it to fit your monitor
screen. Note: Use NORMAL ZOOM to return your plan to its normal size.

GRID
Shows/hides a background grid. Grid lines are helpful in laying out your plan.
Select GRID by clicking on its View menu item or Toolbar icon. Note: To hide
the grid, reclick the View menu item or the Toolbar icon. To set the grid
spacing, select PREFERENCES under the “Options” menu.
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STATUS BAR
Switches the Status Bar, at the bottom of the screen that displays the various
measurements of your selected-object, on/off.

OBJECT SIZES
Switches on/off the small-size display box that appears near objects as they are
drawn and manipulated. This box is referred to as the Status Box, and it tracks
and registers a variety of physical measurements for the selected object.
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TOOL BARS…
Allows you to show/hide the groups of Toolbar icons. Note: Toolbar icons are
loosely grouped into areas of use, e.g. editing, drawing, etc. You can also move
them around the Toolbar. This lets you tailor your Toolbar.
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“ARRANGE” MENU ITEMS
Contains commands: Send TO BACK, SEND TO FRONT, ROTATE LEFT(90),
ROTATE RIGHT (90), ROTATE (180), ROTATE BY DEGREES, LOCK, UNLOCK,
GROUP, UNGROUP, EDIT GROUP And EXIT EDIT GROUP.

SEND TO BACK
Places selected object(s) behind another object(s) on your plan. To send an
object(s) to the back: click on the object(s), then click SEND TO BACK.
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SEND TO FRONT
Brings selected object(s) to the front of other objects on your plan.
To bring object(s) to the front: click on the object(s) you wish to select, then
click on the SEND TO FRONT command.

 

ROTATE LEFT (90)
Rotates the selected object 90° to the left.
To rotate an object: click on the object to select it, then click on the desired
rotate command. Note: You can also rotate 90° to the left by clicking on the
ROTATE LEFT tool button. Most selected objects can also be rotated by
dragging the “+” sign located near one of the selection handles.
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ROTATE RIGHT(90)
Rotates the selected object 90° to the right.
To rotate an object: click on the object to select it, then click on the desired
rotate command. Note: You can also rotate 90° to the right by clicking on the
ROTATE RIGHT tool button. Most selected objects can also be rotated by
dragging the “+” sign located near one of the selection handles.

  

 

ROTATE (180)
Rotates the selected object 180°. To rotate an object, click on the object, then
click on the Rotate 180° command. Note: Most objects can also be rotated by
dragging the “+” sign located near one of the selection handles.
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ROTATE BY DEGREES
Allows you to rotate an object by a specified number of degrees. To rotate an
object, click on the object, then click on ROTATE BY DEGREES. Note: Most
objects can also be rotated by dragging the “+” sign located near one of the
selection handles.

LOCK
Locks the selected object (group of objects) in place. You will not be able to
alter locked objects.
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UNLOCK
Unlocks the locked object(s).

GROUP (CMD+G)
Converts a group of selected objects into a single unit. You can resize the
grouping as a whole, but you must use EDIT GROUP to make any changes to
individual objects.
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UNGROUP… (CMD+U)
Ungroups the selected grouped unit.

  

 

EDIT GROUP
Allows you to edit inside a grouped unit. You can edit each object of the group
separately — rotate, resize, change radius, cut, copy, delete, etc. — without
having to UNGROUP. Select EXIT EDIT GROUP to return to normal editing.
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EXIT EDIT GROUP
Applies your EDIT GROUP changes and exits the command.

“REPORTS” MENU ITEMS
3D Railroad’s “Reports” feature will provide you with easily obtainable
materials and manufacturer’s parts lists to help you keep track of costs,
purchases and inventory information. The “Reports” menu contains the
commands: CREATE MATERIALS REPORT and MANUFACTURER PARTS LIST.
Note: There is a direct relationship between the Reports Menu items and their
corresponding icons on the Toolbar … You can access an action by choosing it
in either place.
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CREATE MATERIALS REPORT
Generates detailed, multi-purpose reports of all the materials/objects in your
plan.
The Materials Report lists each object by manufacturer, scale, name, part
number, and price. It also computes the total cost of all your materials and can
sort your list in a variety of ways. Every item in your plan is listed individually
in a materials report.
The Inventory Materials Report lists each object by manufacturer, scale,
name, part number, quantity, per-piece price and total cost of that particular
item. It also computes the total cost of all your materials and can sort your list
in a variety of ways. For inventory reports, multiple items of the same type are
listed only once and a quantity count is provided.
Note: If you want an object included in these reports, you must complete the
object’s Properties dialog box and click the “Show in report” box.
Select CREATE MATERIALS REPORT by clicking on its menu item or Toolbar
icon.

  

The Materials dialog screen will automatically appear with a list of your
materials/equipment.
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To work with the Materials Report:

1. If the categories of materials/equipment checked on the selection bar at the
bottom of the screen are the ones you wish to view, move to Step #3.

2. If you want to view a different category or set of categories, check your
choices on the selection bar at the bottom of the screen.

3. Select the sort/inventory order by rearranging the choice(s) in the “Sort
order” box. Drag the names to rearrange them. Then, click to place a check
in the “Sort” box. Note: You must also click on the “Inventory” box if you
want an Inventory Materials Report.

4. When you’re satisfied with the categories and sort order of your report, click
on the Print button in the lower right hand corner of the screen.

5. Repeat Steps #2 – #3 until you’ve completed as many sort patterns or
varieties of reports as you want.
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Note: To have additional custom items show up in a materials report, you can
create a small “dummy” object in your plan and set its report properties just for
the purpose of including the information in materials reports. For example, for
an electrical control box, simply draw a rectangle to represent the control, then
click while holding the control key and set the desired properties.

MANUFACTURER PARTS LIST
The Manufacturer Parts List contains product descriptions, part numbers and
prices for track, scenery, structures, rolling stock and electrical parts; as well as
a wide selection of other materials ranging from foam bases and weathering
chalks, to lace curtains and ornate fencing.
You can select any number of these parts and print out a ready-to-go shopping
list, complete with part numbers and descriptions, quantities, total prices and
manufacturer’s name. Note: These price lists were provided by the
manufacturers and were included with the application as a service to 3D
Railroad customers. Please contact the manufacturers directly regarding current
prices, updates or materials questions you might have. Manufacturer addresses
and phone numbers are found under “Credits” on the APPLE menu and in the
General Information section of this manual. The manufacturer parts lists are
editable, and you can create your own lists. This lets you easily enter updated
prices and product information.
Select MANUFACTURER PARTS LIST by clicking on its “Reports” menu item or
its Toolbar icon.

  

The Manufacturer Parts List dialog screen will automatically appear with a
display of a manufacturer’s inventory.
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To use the parts lists:

1. If the inventory displayed is the one you want, move to Step #3.

2. If you want to view another manufacturer’s inventory, click on the Open
window at the lower left corner of the screen and select a parts list.

3. Select the category tab — TRACK, SCENERY, STRUCTURES, ROLLING

STOCK, ELECTRICAL, MISCELLANEOUS, and ALL  — you are interested in.

4. Double click on the inventory item(s) you want. An inventory-sheet icon will
appear to the left of your selection. These checked items are all that will appear
on report printouts. Click the CHECK ALL button to select all items at once.

5. Repeat Steps #3 and #4 until you’ve selected all the items you wish to purchase
from that manufacturer.

6. Click on the Print button at the bottom of the screen.

7. Repeat Steps #2 – #6 until you’ve completed your shopping list.

“OPTIONS” MENU ITEMS
Contains the commands NORMAL TRACK SNAP, SNAP TO GRID, SNAP TO

OBJECT CORNERS, REVERSE TRACK SNAP AND PREFERENCES.
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NORMAL TRACK SNAP

When a track end point is positioned near another track end and the Mouse
button is released, the track pieces snap together at the correct angles. Note:
Curve directions are determined by which end of curves are snapped.

Select NORMAL TRACK SNAP by clicking on its menu item or Toolbar icon

  
   

SNAP TO GRID

If the SNAP TO GRID command is checked, the nearest edge/point of a drawn or
moved object will snap to the grid when the Mouse button is released.

Select SNAP TO GRID by clicking on its “Options” menu item or its Toolbar
icon

 
  

Note: You can specify the grid spacing on the “Metrics & Grid” tab or
Preferences, under the “Options” menu.

SNAP TO OBJECT CORNERS

If the SNAP TO OBJECT CORNERS command is checked, the edge/point of a
drawn or moved object will snap to the corner of the nearest object when the
Mouse button is released. Note: In the case of an arc, the end of the arc will
snap to the corner. This option does not work with circles/ovals as they do not
have corners.

Menus and Buttons
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REVERSE TRACK SNAP

When REVERSE TRACK SNAP is on, it reverses the NORMAL TRACK SNAP

functionality and helps create workable turnouts/switches.

Select REVERSE TRACK SNAP by clicking on its menu item or its Toolbar icon.

  
  

    PREFERENCES

Changes the common 3D Railroad options. Click on Preferences and a
Preferences dialog window with five tabs — METRICS & GRID, 3D VIEW,
TRAIN, OTHER and DIRECTORIES appears.

METRICS & GRID TAB

Sets the unit (e.g. inches, feet, meters, etc.), default train scale and grid width,
height and color.

Units: Sets your measurement preferences: yards; feet, decimal; feet, decimal
inches; feet, fractional inches; inches, decimal; inches, fractional; meter;
centimeters; and millimeters.
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Grid:  Sets grid size and whether or not grid is visible. Note: The grid can also
be shown or hidden by using the SHOW GRID Toolbar button.

Color:  Sets the color of the grid. Click on color bar and the Color dialog box
opens. Refer to the “Using Colors and Patterns” in the What Are the Basics?
section of this manual for more specific information.

Default train scale: You have a choice of nineteen scales. This scale appears as
the default scale in the Track Properties dialog box and determines the rail and
tie spacing drawn with the track tools.

3D VIEW TAB

Sets Benchwork texture, Backdrop information, and background color.

Benchwork texture: Clicking on BROWSE automatically opens the “Textures”
folder for you to select a texture other than the default benchwork texture. Note:
There is a wide range of textures to choose from, such as grass, sand, dirt, and
woodgrains.

Backdrop: If you wish to use a backdrop, click the backdrop box. If you would
like to use something other than the default backdrop, clicking on BROWSE

automatically opens the “Backdrop” folder for you to select a different
backdrop. There are several areas to this dialog box. For more specific
information, refer to the OPEN FILE DIALOG information under the “Properties
Dialog Boxes” in the What Are the Basics? section of this manual.

Background Color: The background color applies when the USE BACKDROP

option is turned off. Click on color bar and the Color dialog box opens
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automatically. Refer to the “Using Colors and Patterns” in the What Are the
Basics? section of this manual for more specific information.

TRAIN TAB

Sets the maximums for five track measurements.

• Maximum distance between track connections. If the distance between two
pieces of track is greater than this distance, the test train will stop. Otherwise
it will jump the gap and continue running.

• Maximum elevation gap between connections. If the elevation difference
between connected track is greater than this, the test train will stop.

• Maximum grade percentage. If the grade of any track is greater than this, the
test train will stop.

• Maximum angle between track connections. If a track connection results in
an angle greater than this, the test train will stop.

• Maximum track bend deformation (0.0 – 1.0) This value determines the
maximum amount the spline and curved track can bend before it’s
considered invalid. The greater the value, the greater the allowable bend. You
will probably want to work with values between 0.01 and 0.10 for testing
layouts. For example, a setting of 0.05 causes the test train to be more
sensitive to sharper bands/curves.

Whenever the test train stops, hold the control key and click the train. Select
Properties to determine the reason.
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OTHER Tab
Sets Snap sensitivity range and Selector tool handle sizes.

FOLDERS TAB

Displays/sets the directory paths for Databases, Libraries, Trains & Cars, 3D
Objects, 3D Textures, Backdrops, Textures, Bitmaps, 3DBitmaps, and Patterns.

“WINDOW” MENU ITEMS

The “Window” menu allows you to switch between any open documents.

“HELP” MENU ITEMS

The Help Menu allows you to access BALLOON HELP.

Menus and Buttons
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WORKING WITH “LAYERS”
You may occasionally find it useful to keep portions of your plan separate from
other parts. 3D Railroad’s multiple layer support lets you easily accomplish
this. It’s a lot like using different layers of tissue sheets or clear overlays. When
the sheets are stacked together, they look like a complete scene but when you
take them apart you find that each sheet has just a portion of the whole scene on
it so you can change or hide/show it without disturbing the rest of the picture.

You can create, edit and view objects on a single layer, a combination of layers,
or on all layers at once. And, even though it’s easy to create and use multiple
layers, you don’t have to use them if you don’t want to. In fact, most of your
plans will probably only need to use a single layer.

The Layers Control Panel is located in the upper right corner of your screen.

You’re actually always using layers because “Layer O” is the default working
layer that the program automatically sets at start up. So, as we said earlier, you
can just go with this single layer or explore the possibilities of using several
different layers. The choice is up to you.

Active Layer: The active layer is the layer you are working on at the particular
moment. Only one layer can be active at a time. You can check to see which
layer it is by looking at the layer display box to the very far right — “Layer 0,”
“Layer 1,” “Layer 2,” etc. Note: The small boxes — 0 through 7 — displayed
on the Layers Control Panel are only used to show/hide layers, they do not
necessarily reflect the layer you’re working on. Objects on hidden layers do not
appear in the 3D view either. This is particularly useful on slower systems
because it gives faster display updates.
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A*M*S*I*
All Model Supply International
PO Box 750638
Petaluma, CA 94975-0638 USA
707 765-9455 Voice
800 227-2460 Order Line

Accurail, Inc.
USA
www.elnet.com/~accurail/

Accurate Dimensionals
4185 South Fox Street
Englewood, CO 80110-4564 USA
303 762-0460 Voice
303 762-0842 Fax

Alexander Scale Models
PO Box 7121
Grand Rapids, MI 49510 USA

Alt ohm Hobby AB
Box 90 133
Stockholm S-120 21
SWEDEN
46 8 999 333  Voice
46 8 99 88 66 Fax

AM Models
9520 E. Napier Avenue
Benton Harbor, MI 49022 USA
616 944-5129 Voice
616 944-1901 Fax
tomarup@juno.com

American Model Builders
Laserkit
1420 Hanley Industrial Court
St. Louis, MO 63144 USA
314 968-3076 Voice
614 968-0799 Fax
laserkit@aol.com
Web Site coming soon

Aristo-Craft Trains
Polk’s Model Craft Hobbies, Inc.
346 Bergen Avenue
Jersey City, NJ 07304-2204 USA
201 332-8100 Voice
201 332-0521 Fax
aristo@cnct.com
www.aristocraft.com/aristo

Athearn, Inc.
The Biggest Little Railroad In America
19010 Laurel Park Road
Compton, CA 90220 USA
310 631-3400 Voice
310 885-5296 Fax
www.athearn.com

Atlas Model Railroad Company, Inc.
378 Florence Avenue
Hillside, NJ 07205 USA
800 872-2521 Order Line
Support@atlasrr.com
www.atlasrr.com
Call for Catalog or Dealer

GENERAL INFORMATION

List of Manufacturers
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Bachmann Industries, Inc.
1400 East Erie Avenue
Philadelphia, PA 19124 USA
215 533-1600 Voice
215 744-4699 Fax

Blair Line
Products For Model Railroaders
PO Box 1136
Carthage, MO 64836
417 359-8300 Voice
417 359-8844 Fax
www.blairline.com

BK Enterprises
12874 County Road 3114B
Buena Vista, CO 81211-9102 USA
719 395-8076 Voice
bktruscale@aol.com

Bowser Manufacturing Co., Inc.
PO Box 322
Montoursville, PA 17754 USA
717 368-2379 Voice
717 368-5046 Fax

Builders In Scale
Switch Master
PO Box 460025
Aurora, CO 80046-0025 USA
303 699-1822 Voice
303 680-6088 Fax
800 884-1822 Order Line
www.buildersinscale.com

Building & Structure Co., The
Tomalco
PO Box 1296
Fenton, MO 63026 USA
618 277-5518 Voice
618 624-3590 Fax
psmith@apci.netwww

Buildings Unlimited
Myron J. Biggar Group, Inc.
65 South Broad Street
PO Box 239
Nazareth, PA 18064-0239 USA
610 759-0406 Voice
610 759-1223 Fax
610 759-0406 Order Line
ogaugerwy@aol.com
www.members.AOL.com/ogaugerwy/OGR.html

Busch
Heidelberger St. Viernheim D-685AG
Germany
620 460-0719 Voice

Centerline Products
18409 Harmony Road
Marengo, IL 60152 USA
815 923-1105 Voice
815 923-1106 Fax

Central Valley
1203 Pike Lane
Oceano, CA 93445 USA
805 489-8586 Voice

General Information
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Chicago Model International
CMI
PO Box 170
Deerfield, IL 60015-0170 USA
847 735-8500 Voice
847 735-8516 Fax
chimdl@aol.com
www.xnet.com/~vmf/cmi

Chooch Enterprises
PO Box 217
Redmond, WA 98073-0217 USA
425 788-8680 Voice
425 788-8680 Fax

City Classics
PO Box 16502
Pittsburg, PA 15242 USA
412 276-1312 Voice
412 276-1312 Fax

Con-Cor International
JMC International
1025 Industrial Drive
Bensenville, IL 60106 USA
630 595-0210 Voice
630 595-0924 Fax
jmcorders@aol.com
www.tucson.com/concor

CVP Products
PO box 835772-B
Richardson, TX 75083-5772 USA
972 422-2169 Voice
972 516-9527 Fax
972 422-2169 Order Line
kggcvp@aol.com
www.cvpusa

Dave’s Custom Model Trees
2207 N.E. 126th Avenue
Vancouver, WA 98684 USA
800 683-1825 ext. #4093 Order Line
dherbenson@worldaccess.net.com

Design Preservation Models
DPM
PO Box 66
Linn Creek, MO 65052 USA
573 346-1234 Voice
573 346-6700 Fax

Detail Associates
PO Box 5357
San Luis Obispo, CA 93403 USA

Digitrax, Inc.
PO Box 1424
Norcross, GA 30091-1424 USA
770 441-7992 Voice
770 441-0759 Fax
sales@digitrax.com
www.digitrax.com

Eaglewings Iron Craft
4007 N 22nd Avenue
Phoenix, AZ 85015 USA
602 437-0844 Voice
602 437-0844 Fax

Eastern Car Works, Inc.
PO Box “L” 624
Langhorne, PA 19047 USA
www.easterncarworks.com
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English’s Model Railroad Supply
Bowser Manufacturing Company, Inc.
PO Box 322
Montoursville, PA 17754 USA
717 368-2379 Voice
717 368-5046 Fax

Evergreen Hill Designs
Oso Publishing Company
PO Box 5127
Oso, WA 98223 USA
360 403-0569 Voice
800 337-3547 Order Line
davidry@tgi.net
www.osorail.com

Frog Chronicles, The
Green Frog Productions Ltd.
200 N. Cobb Parkway, Suite 138
Marietta, GA 30062-3538 USA
770 222-2220 Voice
770 422-2467 Fax
800 227-1336 Order Line
grnfrog@atl.mindspring.com
www.greenfrog.com

GarGraves Trackage Corporation
8967 Ridge Road
North Rose, NY 14516-9793 USA
315 483-6577 Voice
315 483-2425 Fax
ggtrack@aol.com

Great West Models, Inc.
PO Box 224
Franktown, CO 80116 USA
303 840-0872 Voice
303 841-8517 Fax

Hillcraft Model Builders
2142 Oak Canyon Lane
Chino Hills, CA 91709 USA
909 393-0645 Voice
909 393-2488 Fax

Integrated Signal Systems
PO Box 25451
Rochester, NY 14625-0451 USA
716 586-2032 Voice
isswalt@aol.com

International Hobby Corp.
413 East Allegheny Ave.
Philadelphia, PA 19134 USA
215 426-2873 Voice
215 634-2122 Fax

Kato U.S.A., Inc.
100 Remington Road
Schaumburg, IL 60173 USA
www.katousa.com

LGB of America, Inc.
6444 Nancy Ridge Drive
San Diego, CA 92121-2296 USA
619 535-9387 Voice
619 535-1091 Fax
www.lgb.com

Life-Life Products
1600 Union Avenue
Baltimore, MD 21211-1998 USA
410 889-1023 Voice
800 937-3626 Fax
800 638-1471 Order Line

General Information
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Lionel LLC
Lionel
50625 Richard W. Blvd.
Chesterfield, MI 48051-2493 USA
810 949-4100 Voice
810 949-3273 Fax
lionelmi@aol.com
www.lionel.com

Looks Like Paper Models
4260-1 Crooked Tree SW
Wyoming, MI 49509 USA
616 532-5788 Voice
looks-like@juno.com

Mainline Hobby Supply
1325 Ferguson Avenue
St. Louis, MO 63133 USA
314 726-1661 Voice
314 726-1698 Fax
thorne@prodigy.net

Marklin Trains
PO Box 510559
New Berlin, WI 53151 USA
800 825-0888 Order Line
www.marklin.com
Call for nearest dealer

Micro Engineering, Inc.
1120 Eagle Road
Fenton, MO 63026 USA
314 349-1112 Voice
314 349-1180 Fax
800 462-6975 Order Line

Midwest Products Co. Inc.
400 S. Indiana St.
PO Box 564
Hobart, IN 46342 USA
800 348-3497 Voice
219 942-5703 Fax

Miniatronics
561-K Acorn Street
Deer Park, NY 11729 USA
516 242-6464 Voice
516 242-7796 Fax
800 942-9439 Order Line
miniatronics@earthlink.net
www.miniatronics.com

Model Power
180 Smith Street
Farmingdale, NY 11735 USA
516 694-7022 Voice
516 694-7133 Fax
800 628-2803 Order Line
Quality and Affordability

Northeastern Scale Models
PO Box 727
Methuen, MA 01844 USA
978 688-6019 Voice
978 794-9104 Fax
nesm@tiac.net
www.nesm.com

O Gauge Railroading
Myron J. Biggar Group, Inc.
65 South Broad Street
PO Box 239
Nazareth, PA 18064-0239 USA
610 759-0406 Voice
610 759-0223 Fax
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610 759-0406 Order Line
ogaugerwy@aol.com
www.members.aol.com/ogaugerwy/org.html

Oregon Rail Supply
PO Box 490
Scappoose, OR 97056-0490 USA
503 543-6466 Voice

Peco
Pritchard Patent Product Company Limited
Underlys, Beer, Nr. Seaton
Devon; EX12 3NA U.K. England UK Seaton 01297 21542
Seaton 01297 29229 England

Piko
Lutherstrafle 30
D - 96505 Sonneberg
Germany
+ 49 (36 75) 89 72 0 Voice
+ 49 (36 75) 89 72 50 Fax
info@piko.de
www.piko.de

Pikestuff
Rix Products
3747 Hogue Road
Evansville, IN 47712 USA
812 426-1749 Voice
812 423-3174 Fax
rix@rixproducts.com
www.rixproducts.com

Pre-Size Model Specialties
2701 Conestoga Drive #101
Carson City, NV 89706 USA
702 883-4798 Voice
702 883-4799 Fax

Precision Products
763 Cayuga Street, Unit #2
Lewiston, NY 14092-1724 USA
716 754-2997 Voice

R.K. Enterprises
65 Rosedale Road
Carmel, NY 10512 USA
914 225-7051 Voice
914 225-7051 Fax
highrails@put.com
www.idsi.net/highrails

Rail Clamps
PO Box 1253
Lodi, CA 95241 USA
209 369-1868 Voice
209 369-1868 Fax
www.largescale.com/hillman

RailRoad Ave
Box 550
Willits, CA 95490 USA
707 459-2770 Voice
707 459-4253 Fax
rrave@saber.net

Roco
Roman & Company
41 West 245 Prairie View Lane
Elburn, IL 60119 USA
630 262-1560 Voice
630 212-1778 Fax
rocousa@inil.comroco.com

Shinohara Trackage
Lambert Associates
28312 Industrial Blvd., #D
Hayward, CA 94545-4435 USA

General Information
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510 783-9712 Voice
510 783-9715 Fax
510 783-9712 Order Line

TDV/H&R Trains
6901 US Hwy 19 North
Pinellas Park, FL 33781 USA
813 526-4682 Voice
813 526-3439 Fax

Tillig Pilz
Reynauld’s Euro-Imports, Inc.
113 South Third Street
Geneva, IL 60134 USA
630 262-0771 Voice
630 262-0778 Fax
eurotrains@inil.com
euro-trains@inil.com

Tomar Industries
9520 E. Napier Avenue
Benton Harbor, MI 49022 USA
616 944-5129 Voice
616 944-1901 Fax
tomarup@juno.com

Tool Man, The
Nova Distributing
7621 Lake Highlands Drive
Fort Worth, TX 76179 USA
817 236-7609 Voice
817 236-7609 Fax
toolman@airmal.net
www.hobbytools.com

True-Scale Models, Inc.
12874 County Road 314B
Buena Vista, CO 81211-9102 USA
719 395-8076 Voice
Bktruscale@aol.com

Turnouts
The Parker Co.
PO Box 1546
Camarillo, CA 93011 USA
805 388-1380 Voice
805 987-6432 Fax
coparker@msn.com
www.vcnet.com/-coparker

Westerfield
53 River Lane
Crossville, TN 38555 USA
931 484-7233 Voice
931 456-4122 Fax
westerfield@multipro.com
www.multipro.com/westerfield

Western Scale Models
PO Box 7074
Northridge, CA 91327-7074 USA
818 368-7033 Voice
818 368-7033 Fax

Wm. K. Walthers, Inc.
5601 West Florist Avenue
PO Box 3039
Milwaukee, WI 53201-3039 USA
414 527-0770 Voice
414 527-4423 Fax
800 877-7171 Order Line
www.walthers.com

Woodland Scenics
PO Box 98
Linn Creek, MO 65052 USA
573 346-5555 Voice
573 346-3768 Fax
sales@woodlandscenics.com
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COMMAND CARD

3D RAILROAD TOOLBAR BUTTONS

Button Name Description

New (Cmd+N) Opens a new, untitled, empty plan window.

Open (Cmd+O) Opens a previously saved plan from disk.

Save (Cmd+S) Saves the plan you’re currently working on to disk, keeps the same name.

Print Preview Shows a preview of how a plan will print .

Print Prints a plan to paper.

About Shows information about the program.

Help Shows on-line help information.

Tool Parameters Sets plan’s tool default settings.

Zoom In (Cmd+PgUp) Enlarges a plan for detailed editing.

Zoom Out (Cmd+PgDn) Reduces a plan to see more at once.

Cut (Cmd+X) Removes objects and places them onto the clipboard.

Copy (Cmd+C) Copies objects and places them onto the clipboard.

Paste (Cmd+V) Inserts clipboard objects into a plan.

Undo (Cmd+Z) Reverses the most recent draw/edit operation.

Create Materials Report Displays a list of all objects/materials in the current plan. Allows sorting,
printing, etc..

Manufacturer Parts List Displays part lists for a variety of model railroad manufacturers’ products.
Allows editing or creating custom shopping lists.

General Information
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Layers Number buttons show/hide layers. Pop-up menu selects working layer.

Selector Selects objects for other operations. Moves, resizes, rotates objects.

Sketch Draws a freehand, sketched object.

Line Draws a line between two points.

Box Draws a rectangular box or square.

Rounded Box Draws a rectangular box or square that has rounded corners.

Arc Draws an arc.

Circle/Oval Draws a circle or oval.

Polygon Draws a polygonal object of line segments.

Spline Draws a spline based curve.

Text Enters text on plan.

Rotate Rotates objects around an origin point

Measure Line Measures the distance between two points.

Measure Box Measures a rectangular/square area.

Dimension Line Draws an editable dimension line.

Dimension Angle Draws an editable dimension arc for angles.

Put selection into library Puts objects into the currently active symbol/object library.

Get selection from library Displays and retrieves objects from the currently active object library.

Insert Picture Imports a bitmap picture (*.bmp file) and inserts it into 2D plan window.
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Insert 3D Bitmap Imports bitmap (*.bmp) and mask (*.msk), and inserts it into 3D window.

Insert 3D Object Imports a 3D object (3D Studio or DXF)

Benchwork Draws polygonal benchwork structures that appear in the 3D view.

Train Creates a train for testing layout functionality.

Send selection to front Moves objects in front of other overlapping objects.

Send selection to back Moves objects behind other overlapping objects.

Group (Cmd+G) Groups multiple objects so they are treated as a single object.

Ungroup (Cmd+U) Ungroups objects into their original component parts. Reverses Group.

Rotate Right Rotates objects 90 degrees to the right.

Rotate Left Rotates objects 90 degrees to the left.

Grid Shows/hides grid lines.

Straight Track Draws a straight section of track.

Curved Track Draws a curved section of track.

Oval Track Draws an oval section of track.

Spline/Flex Track Draws a spline-based section of track (simulates flex track).

Transition Track Creates connecting track between two separate track sections

Normal Track Snap When on, connects/snaps track pieces together at the correct angles.
(Curve directions are determined by which end of curves are snapped).

Reverse Track Snap Click to toggle on/off. When on, creates workable turnouts/switches.

General Information
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MOVEMENT CONTROLS

Camera move forward Camera move backward

Camera turn left Camera turn right

Camera move up Camera move down

Camera move left Camera move right

Camera tilt forward Camera tilt backward

Camera tilt left Camera tilt right

Reset camera

VIEW CONTROLS

From birds-eye view From left side view

From right side view Front view

Back view Lightens 3D view

Darkens 3D view

Snap to Grid Snaps the nearest edge/point of a drawn or moved object to the grid.

Snap to object corners Snaps a drawn or moved object to other object corners.

3D VIEW

Camera Creates 2D camera for controlling 3D-view-perspective.

3D view Opens a window and creates 3D view of current plan.

3D wireframe Shows the 3D view as a wireframe.
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METRIC CONVERSION TABLES

Metric To English English to Metric

From To Multiply by From To Multiply by

meters yards 1.094.0000 yards meters .9144

meters feet 3.2810 feet meters .3048

meters inches 39.3700 inches centimeters 2.5400

kilometers miles .6214 miles kilometers 1.6090

General Information
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Index
Symbols

3D Backdrop  61
3D Bitmap

Insert  62
3D Linked Bitmap

Create  62
3D Linked Object

Create  62
3D View

3D View Tab
Backdrop  142
Background Color  142
Benchwork Texture  142

3D Walk Around  56
Movement  56

A
Arrow

Width & Length  30

B
Benchwork

Custom  44, 59
Tool  44

Bumper  49

C
Colors Dialog Box  27
Command Card  154



160

Control Symbols  22
"+" Sign  25
Circles  24

Radius Handles  24
Resizing Handles  24
Round Boxes  25

Selector  22
Squares  23

Black  23
Hollow  23

D
Drawing  20

Preferred Drawing Units  43

E
Erasing Objects  25

G
Group Properties Dialog Box  32

I
Installation  12
Inventory Materials Report  136

K
Keyboard  20

Drawing Keyboard Shortcuts  21
Menu Keyboard Shortcuts  20
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L
Layout

Size  44
Library

Get Object From Library  116
Linked Bitmap

Put Into Library  62
Linked Object

Put Into Library  62
Symbol  52

Creating  61
Get from library  51

M
Main Menu Bar  21, 67

"Arrange" Menu Items  129
Edit Group  134
Exit Edit Group  135
Group  133
Lock  132
Rotate (180°)  131
Rotate By Degrees  132
Rotate Left (90°)  130
Rotate Right (90°)  131
Send to Back  129
Send to Front  130
UnGroup  134
Unlock  133

Command Keys
Definitions  21

"Edit" Menu Items  73
Copy  74
Cut  74
Duplicate  74
Paste  74
Properties  75
Select All  75
Undo  73

"File" Menu Items  68
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Close  69
Document Setup  70
New  68
Open  68
Print  72
Print 3D View  72
Print Preview  71
Print Setup  70
Save  69
Save As  69

"Help" Menu Items  144
Menu Items

Show 3D View  56, 118
"Options" Menu Items  139

Normal Track Snap  140
Preferences  141
Reverse Track Snap  141
Snap to Grid  140
Snap to Object Corner  140

"Reports" Menu Items  135
Create Materials Report  136

"Tools" Menu Items  75
3D View submenu  117–145
Adjust Camera Angle  78
Arc  86
Box & Oval  83
Dimension Submenu  101–145
Draw dimension angle  103
Draw dimension line  101
Draw measure box  106
Draw measure line  105
Draw submenu  80–145
Get object from library  113
Insert 2D bitmap picture  108
Insert 3D Bitmap  109
Insert 3D Object  110
Insert Benchwork  111
Insert submenu  108–145
Library submenu  112
Line  82
Polygon  87
Rotate Around Origin  79
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Round Box  85
Run Test Train  76
Selector  79
Sketch  80
Spline  89
Text  91

"Track" menu items  93–145
Curved Track  96
Oval Track  97
Spline Track  99
Straight Track  94

"View" Menu Items  117
Back-Side View  123
Bird's Eye View  120
Darken  123
Fit To Screen  126
Front-Side View  122
Grid  126
Left-Side View  121
Lighten  123
Normal Zoom  125
Object Sizes  127
Reset Camera  120
Right-Side View  122
Show 3D As Wireframe  119
Status Bar  127
Tool Bar  128
Zoom In  124
Zoom Out  124

"Window" Menu Items  144
Manufacturer Parts List  138
Manufacturer Price List  52
Materials Report

Definition  136
Metrics

Conversion Table  158
Metrics & Grid  43
Mouse  19
Moving  19

Around in 3D Window  118
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P
Patterns Dialog Box  27
Place Holder

Symbol  115
Pointing

Selector Arrow  19
Polygon

Resizing  24
Preferences

3D View Tab  142
Directories Tab  144
Metrics & Grid Tab  141
Other Tab  144
Train Tab  143

Properties Dialog Box  20, 26
2D Object  40
3D Bitmap  37
3D Object  38
Benchwork  60
Open File  31
Track  32
Train  58

R
Reports

Dialog Box Information Section  30
Resizing  19, 23

Grouped Symbols  52, 54, 113
Track  24

Rotating  20

S
Selecting

Objects & Text  19, 22
multiple objects  80

Set Camera Position  77



165
3D Railroad

Settings Information  31
Spiral Helix  36
Status Bar  21
Symbol

Creating  62
Library  50

Put Into Library  62
System Requirements  12

T
Technical Support  14
Textures Dialog Box  29
Toolbar

Buttons
3D View  157
Definition  154

Track
Drawing

Curved  45
Straight  44

Layout
Oval  47

Library  50
Properties Dialog Box  32
Snapping

Curved  45
Normal  48
Reverse  48

Tools  43
Train

Scale  44, 142
Test Train

Running  57
Turnout & Switches

Layout  47, 60
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V
View

3D
Movement  157

X
"X" Box

Creating  63


